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Chapter 4

The Job Editor
The Job Editor’s main function is to collect files for printing, set printing 
parameters, create the print job ticket and send the file for printing. The Job Editor 
can also:

• Create print jobs containing multiple format image files
• Sort files
• Choose which page to print from a multipage document
• Create and save pen sets
• Reduce and enlarge images
• Add watermarks, labels and overlays
• Add margins and justify the image on the medium
• Nest jobs
• Send jobs over a network, modem or disk
• Print digitally collated sets
• View images before printing
• Process files to check for errors before submitting
• Apply finishing options like folds, binding, hole punching etc.
• Add images to a job directly from a Twain device.
• Poll a Network or FTP directory
• Compare two documents and report changes or differences
• Convert files into TIFF or PDF file formats
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The Job Editor is used is used to add images to a job file, also referred to as a job 
ticket. You can then edit print parameters for each job individually. You can also 
apply commonly used print parameters to the Prototype job. Print Parameters 
applied to the Prototype job, are applied by default to each image added to a job. 
Print parameters for images, or the prototype, can be changed, as desired. 
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Creating a simple job ticket
To start a new job ticket:
1. Open the Job Editor. 
2. Click on the New Job button, or select New from the File menu.

Now add image files to the job. These can be in any supported format. Multiple 
supported file formats can be added to the same job. Image files are printed in the 
order they are listed in the job ticket.

To add images to a job ticket:
1. Click Add Files.
2. The Look In field displays the directory in which you last saved files.
3. Select the file(s) you want to add. Select multiple files using the Shift or Ctrl 

keys. 

PlotWorks supports the Windows “drag-and-drop” method of adding files. 
Simply drag the image files from the Window Explorer window and drop them 
onto the Job Editor grid.

4. Click Open. The Job Editor automatically detects the image file formats and 
adds the images to the job grid. If the Job Editor does not recognize a file 
format, the Unrecognized File Format dialog box appears. You can then 
choose to skip the file(s) or add them with the format value User Specified.

Fig 4.2 
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To Skip a File Listed in the Unrecognized Format Dialog Box:

1. Click on the file in the select box.
2. Click on the Skip button
To Add a File as listed in the Unrecognized Format Dialog Box

1. Click on the file in the select box. The Add button becomes available.
2. Click on the Add button. The file is added to the job ticket as User Spec-

ified. 
5. Once image files are added to a new job ticket, you can set printing 

parameters. When done, click on the Output button to send the job for 
printing.

Adding DWF Files to the Job Editor

Before a DWF file can be added to the Job Editor, it is necessary to ensure that 
all fonts are already embedded in the DWF file.

DWF files can be manually added or imported from AutoDesk. Manually add a 
DWF files the same way you add other files to the job grid. 

When a multiple sheet DWF file is added, each sheet appears as a separate line 
item in the job grid with the sheet name and number appended to the file name. 
Individual sizes are supported for multipage DWF files.

If the DWF file is password protected, the Missing or Invalid Password dialog box 
appears. Enter the password and then click OK. When multiple password 
protected files are added, PlotWorks will prompt you as necessary for additional 
passwords.
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The Job Editor Window
This section provides a brief description of the Job Editor window components. 

The Toolbar
The following buttons appear on the Job Editor toolbar:

• New Job: Creates a new, blank job file.

• Open Job: Opens an existing job file.

• Add Files: Adds image files to the print job.

• Save Job: Saves the current job file.

• Cut: Removes the selected row from the grid placing it in temporary 
memory. From there, it can be pasted into a new position or in a different job 
file. 

• Copy: Places a duplicate of the selected row in temporary memory. The 
duplicate can be pasted and edited apart from the original.

• Paste: Pastes the last row placed in temporary memory onto the grid.

• Delete: Removes the selected row(s) from the grid.

• Properties: Displays or hides the Detail Property Sheet.

• Process: Processes selected images or all images in a job.
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• Revision Highlighting: Compares two documents that are generated in the 
same way, and illustrates the differences between the two files. Revision 
Highlighting cannot be used with scanned images

• View: Processes the selected image and displays it in the viewing application.

• Output: Is used to set up output options and to send entire jobs or selected 
files to a specified destination.

• Scan: Opens the optional Scanner Interface application.
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The Menus
The File Menu

Fig 4.3 
The Job 

Editor File 
menu

The File menu contains options for job tickets. 

These include:

• New Job: Creates a new, blank job ticket. (Keyboard shortcut: Ctrl+N)
• Open Job: Opens an existing job ticket. (Keyboard shortcut: Ctrl+O)
• Open Pen Set: Applies an existing pen set to the selected image.
• Add Files: Adds images to the print job.You can add files from a directory 

on your network, or from an FTP directory. (Keyboard shortcut: Insert)
• Templates: Is used to save and open settings created for watermarks, margins 

and labels.
• Scan: Opens the Scanner Interface application if installed. (Keyboard 

shortcut: Ctrl+A)
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• Twain: Adds images from a Twain scanner to a job ticket.
• Process All: Processes all images in a job.
• Process Selected: Processes the selected file(s) in the grid.
• Output to File: Is used to convert and save a file as a TIFF or PDF file. It can 

be used to create multi-page TIFF or PDF files and change other file 
properties. For more information refer to page  4-94.

• Output Job: Is used to select output options and output the job. (Keyboard 
shortcut: Ctrl+J)

• Save Job: Saves the active job ticket. (Keyboard shortcut Ctrl+S)
• Save Job As: Saves the active job ticket under a selected new name. The 

original document will still exist under its original name. The new document 
displays in the active window.

• Save Pen Set: Saves the selected file’s pen set, under a specified filename.
• Save Configuration: Saves job-wide settings to the configuration file, 

conf.plp. 
• 1, 2, 3, 4 . . . etc.: Opens the selected job ticket.
• Exit: Exits the Job Editor, prompting you to save unsaved changes, if any. 

The Edit Menu

The Edit menu contains options used to organize image files on the grid. 

Fig 4.4 
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The following items are available under the Edit menu:

• Cut Row: Removes the selected row from the grid and places it in temporary 
memory. From there, it can be pasted into a new position in the same or 
different job ticket. (Ctrl+X)
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• Copy Row: Places a duplicate of the selected row in temporary memory. 
(Ctrl+C)

• Paste Row: Lets you paste a row from temporary memory onto the job grid. 
(Ctrl+V)

• Delete Row: Deletes a row from the job ticket. This does not delete the actual 
image file from your computer.

• Copy Row to Prototype: Copies all image file parameters to the Prototype 
row.

• Copy Field: Copies the value of a selected field to other fields in the same 
column. This is useful when you want to change all values in a column 
efficiently. (Ctrl+R)

• Copy Field Up: Copies the value of the selected field to all fields above the 
selected field in the same column. (Ctrl+U)

• Copy Field Down: Copies the value of the selected field to fields below it in 
the same column. (Ctrl+I)

• Sort by Column: Sorts selected columns alphabetically. (Ctrl+M)
• Revision Highlighting: Compares two documents that are generated in the 

same way, and illustrates the differences between the two files. Revision 
Highlighting cannot be used with scanned images.

The View Menu

The View menu is used to change the appearance of the Job Editor window, and 
for processing and viewing options. 

Fig 4.5 
The Job 

Editor 
View menu

menu

The following items are available under the View menu

• Toolbar: Hides or shows the toolbar. 
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• Status Bar: Hides or shows the status bar. 
• Property Sheets: Hide or shows the Detail Property Sheet. 
• Scale View: Hides or shows an illustration depicting the original and output 

size of a selected image.
• Move Up: Moves the cursor up one row in the grid. (F7)
• Move Down: Moves the cursor down one row in the grid. (F8)
• View Image: Processes the selected image and displays it in the selected 

viewing application. (Ctrl+Shift+V)
• Title Block Location Viewer: Opens the Title Block Location dialog box 

when an image is selected in the job grid. This is useful when using a GFI 
folding device. For more information refer to “Using the Title Block Location 
Dialog Box” on page 11-19.

• Refresh Viewer: Updates the Image Viewer window. (F5)
• Always Use PlotWorks Viewer: Forces the PlotWorks Image Viewer to 

open when you select View Image, regardless of the file format.

NOTE: Double-clicking on a file in the Job Editor opens the Viewer with the 
selected image file displayed.

• Do not show splash screens: Select this option to disable the splash screens 
Splash screens are the windows that appear briefly when PlotWorks 
applications are first launched. The splash screens are enabled by default. 
When disabled a check mark appears beside this option.

The Setup Menu

The Setup menu is used to configure the job ticket. 

Fig 4.6 
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The following items are available under Setup

• Preferences: Is used to set job-wide preferences.
• Processing Options: Is used to set job processing options.
• Configure Destinations: Is used to set up output destinations.
• Configure Viewers: Is used to select third party image viewers. Selecting 

this menu item opens the Configure Viewers dialog box. 
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Fig 4.7 
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Select the file type from the Data Type drop down list and then select the 
viewer you would like to use for this file type from the Viewer path drop 
down list. The viewer must support the file format that you wish to display. 
If the Viewer you wish to use is not listed, click on the provided browse 
button and select the application file for the viewer you want.

The “Always Use PlotWorks Viewer” setting in the View menu over rides choices 
made here.

• Twain Options: Is used to access the Twain Scanning Options dialog box. 
This is described in detail under “Adding Files from a Polled Directory” on 
page 4-78

The Help Menu

The Help menu provides access to online help files and program information.

The following options are available under Help:

• Online Manual: Opens the online manual at the Job Editor chapter
• Index: Displays the help index file.
• Table of Contents: Displays the table of contents for the online manual
• Release Notes: Displays the latest PlotWorks information.
• About: Displays program version and copyright information.

Fig 4.8 
The Job 

Editor 
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menu
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The Job Grid
When images are added to a job ticket, they are listed in the job grid and assigned 
the same parameters as the Prototype row, except for the file name and type. Each 
row of a job grid represents an image file and the parameters assigned to it. 

Print parameters can be changed directly on the job grid. Simply click in the cell 
you want to edit. Either the cursor will flash, indicating that you can type in your 
changes, or the cell will change to display a drop down list that you can select 
from.

Fig 4.9 
The Job 

Editor 
Grid

.

The first row of the grid, Proto, lists a set of default parameters. Images added to 
a job are listed beneath the Proto row.

To move through the grid use the:

• Scroll bars
• Arrow keys on your keyboard
• Arrow keyboard equivalents: F7 (up) and F8 (down)
• Page Up and Page Down keys
• Click on the desired cell with the mouse

The Job Grid Columns

The columns of the grid display the assigned printing parameters for each job. 
Depending on the image format, some print parameters do not apply. Those cells 
display a line. 

The following columns are available:
• Filename: The image file name, not including its three-character extension.
• Ext: The file extension.
• Status: The processing status of an image file is displayed automatically in 

the status column. The following processing statuses are used: 

• O: User selected Ignore Warnings or Ignore All

• W: Processing warnings

• - : The image was skipped during processing
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• C: The image was prechecked successfully. All needed information and 
reference files, etc., exist

• P: The image was processed successfully

• F: The file could not be processed or printed due to fatal errors.

Job tickets created with DOS PlotWorks, display the following statuses:

• ?: The image was printed with warnings

• ±: The image was corrected with Error Free Printing

• *: The image was printed successfully
• Qty: Stands for Quantity. Enter the number of copies to print, up to 99. Enter 

X or 0 for overlays and other files you do not want to print.
• Size: Select the original image size. To enter a custom size, select User 

Specified, then enter the width, height, and origin values on the Specified 
Size tabbed dialog box. To auto detect the image size, select Auto Detected.

• Media: Select a printing medium.
• Output: Select a finished size for the print, or select a percentage of the 

original size. To enter a custom size, open the Detail Property Sheet and 
click on the Output Setup tab. In the field labeled Output Size, select User 
Specified, then enter the width, height, and origin values. To force the use of 
the closest standard media size, select Auto Standard.

• Pens: This field always displays User Specified. To use a different pen set, 
use the Pens tabbed dialog box or import a previously defined pen set.

• Format: The image file data format. The Job Editor automatically detects 
this format when you use the Add Files option. PLP recommends that you do 
not change automatically detected format values.

• Scale: This column is used only for AutoCAD or MicroStation files. Enter 
one of the following in this cell:

• A valid AutoCAD scale (printed units = drawing units).

• A valid MicroStation scale (master units per inch) for MicroStation DGN 
files.

• FIT, for automatic scaling depending on the Specified Size. Refer to 
“Specified Size tabbed dialog box” on page 4-18 for more information. 

Scaling to FIT cannot be used when the Specified Size is set to Auto Detected.

• Plot by: This column only applies to AutoCAD or MicroStation drawings 
and is used to select printing boundaries. The following boundaries are 
available:
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• Extents: Prints all drawn entities in the image file.

• Display: Prints the last saved screen display of the image.

• Limits: Prints a specified range of coordinates.

• View: Prints a predefined view. MicroStation drawings are always 
printed based on a view. 

• Layout: This boundary can only be used with AutoCAD 2000 
processing. it prints a predefined layout.

• View Name: Cells in this column are only available when View is selected 
in the Plot By field for AutoCAD or MicroStation drawings. 

Allowable entries for Microstation files are:

• the saved view name

• the special view names of 1 through 8 (representing the allowable 
MicroStation view window numbers);

• a selection cell name in addition to a view name or number. For example: 
topview CELL<linepa> where topview is a name given to a view and 
linepa is a named cell.

• Watermark: The watermark text is displayed in this field when a watermark 
is applied to the image, See “Watermarks tabbed dialog box” on page 4-34.

• Justification: This field is used to justify the image on the media. See 
“Adding Margins” on page 4-39.

• Mirror: Select whether or not to mirror the image.
• Label: This field is used to enter label text. See “Adding a Label to the 

Printed Image” on page 4-43.
• Overlays: This field displays the number of files selected as overlays. Up to 

ten images can be layered on an image. 

Overlay file(s) have to be added to the job ticket with a quantity of X or 0. See 
“Overlays tabbed dialog box” on page 4-31.

• Title Block: This option is used with GFI folding devices. Select either the 
location of the title block or Don’t Care from this drop down list. For more 
information refer to “Specifying the Title Block Location” on page 11-17.

To change a column width:

1. Place your cursor on the right-hand edge of the column heading. The cursor 
changes to a vertical bar crossed by a double-headed arrow. 

2. Drag the cursor to the desired width.
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Changing Print Parameters
To change prototype parameters:

Changes made to the Proto line affect all files you added thereafter. Changes do 
not affect files already added.to a job ticket.

1. Either:

• Edit the fields on the Prototype row of the grid or on the Detail Property 
Sheet. 

• Select a row on the grid that contains the desired print parameters.Then 
select Copy to Prototype from the File menu. The print parameters are 
copied to the Prototype row. 

2. Click on the File menu

3. Select Save Configuration.

Editing Functions
The editing functions are useful for changing the order of image files and for 
copying multiple parameters at once.

To cut a row from the grid:

1. Select the row you want to cut by clicking on its row number. To select more 
than one row, hold down the Shift or Ctrl key while selecting.

2. Click Cut (or press Ctrl+X). 

To copy a row on the grid:

1. Select the row you want to copy by clicking on its row number. To select 
more than one row, hold down the Shift or Ctrl key while selecting.

2. Click Copy (or press Ctrl+C). 

To paste a row onto the grid:

1. Cut or copy the row you want to paste (see above).
2. Select the row above the spot where you want to paste.

3. Click Paste (or press Ctrl+V).

To delete a row from the grid:

1. Select the row that you want to delete by clicking on its row number. To select 
more than one row, hold down the Shift or Ctrl key while selecting.

2. Click Delete.
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To copy a field to the entire column:

1. Select the field.
2. Open the Edit menu and select Copy Field. The value is copied to all images 

in the job including the Prototype row.

Change Image Filenames
You can change the name or extension of a file listed in the grid. 

The Job Editor supports duplicate filenames in a job as long as the files are the 
same.

To edit a file name:

1. Select (highlight) the filename or extension you wish to rename.
2. Type the desired filename or extension and press Enter.

3. You are prompted: “Rename <oldfile.ext> to <newfile.ext>?” Click Yes. The 
file is renamed in the job grid as well as in the source directory.

Saving a Job Ticket
Once you have created a job ticket, you can save it for future editing or print-on-
demand.

To save a job ticket:
1. Click Save Job.
If you have not previously saved the file, you will be prompted to enter a filename 
and to select a location for your new job ticket. See below for instructions.

To save a job ticket under a new name:
1. Open the File menu and select Save Job As.
2. Type the new name of the file in the Filename field. You can use long 

filenames for your job tickets.

Long filenames are supported in all cases where the destination of the job output 
supports long filenames. Examples of where long filenames are not supported are 
when: outputting to a removable disk (in case the final destination cannot handle 
long filenames), outputting through DOS, or outputting to an older Novell 
network or server. Filenames are truncated when necessary.
.

3. In the Save In field, select a directory to save the file in. Always save the job 
ticket in the same directory as the source files that are in the job.

4. Click Save.
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When you use the Save Job As command, if the job was previously saved under 
a different name, the old job is still saved with its original name and the new job 
is active in the Job Editor grid.
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The Detail Property Sheet
The Detail Property Sheet is a set of nine tabbed dialog boxes used to enter and 
edit parameters for individual image files. The Main tabbed dialog box contains 
most of the basic parameters shown on the grid. The other tabbed dialog boxes are 
used to further customize printing parameters.

To view the Detail Property Sheet:

To display the Detail Property Sheet if it is not already displayed, either:

• Select Property Sheet from the View menu 
• Click on the Properties button.

Fig 4.10 
Main 

tabbed dia-
log box 

The Detail Property Sheet can be moved around your computer screen as needed. 
Simply click on its title bar and while holding the mouse button down drag the 
dialog box to a new location and then release the mouse.
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Selecting parameters on the Detail Property Sheet:

1. Select an image on the grid by clicking on its row number.
2. Choose the tabbed dialog box you want by clicking on its tab.

3. Enter or edit the fields provided.

Main Tabbed Dialog Box
The Main tabbed dialog box of the Detail Property is used to define basic print 
parameters. It contains many of the fields shown on the job grid. 

The Main tabbed dialog box contains the following fields and button:

• Filepath: The complete path to the file, e.g., C:\Program Files\PLP\ 
Plotworks\SampleCC1.

• Filename: The name of a linked image file (not including its three-character 
extension).

• Browse: Is used to navigate and select a file files to replace the file currently 
selected on the job grid.

• Quantity: Enter the number of copies desired. Enter “X” or “0” for overlays 
and for files that you do not want to print. 

• Specified size: Select the original image size. To enter a custom size, select 
User Specified, then enter the width, height, and origin values on the 
Specified Size tabbed dialog box (refer to Fig 4.12). To automatically detect 
the image size, select Auto Detected.

• Output size: Select a finished size for the print, or select a percentage of the 
original size. To enter a custom size, select User Specified, then enter the 
width, height, and origin values in the Output Setup tabbed dialog box (refer 
to Fig 4.14). To print on the next largest standard media size, select Auto 
Standard.

• Media: Select a printing medium from this drop down list. Choices 
include: 

• Bond 
• Vellum
• Film
• T-bond
• Unspecified: Unused media type
• Heavy Bond: This is equivalent to Repro Desk’s Bond 110g
• Heavy T-Bond: This is equivalent to Repro Desk’s T-Bond 110g
• Film 4.5mil: This is equivalent to Repro Desk’s Film 4.5mil
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• Special Bond: This is equivalent to Repro Desk’s *Bond
• Special Heavy Bond: This is equivalent to Repro Desk’s *Bond 

110g
• Special Vellum
• Special Film
• Special T-Bond
• Premium Bond
• Premium Vellum
• HPH (High Pressure Heat) Vellum
• Antistatic Film
• Opaque Film
• Clear Film
• Contrast Film
• Bond 80g
• T-Bond 80g
• Bond 90g/24lb
• T-Bond 90g/24lb
• Recycled Bond
• Medium Blue Bond
• Bright Blue Bond
• Goldenrod Bond
• Bright Yellow Bond
• Green Bond
• Orange Bond
• Pink Bond
• Gray Bond
• Beige Bond
• Fluorescent Yellow Bond
• Fluorescent Green Bond
• Fluorescent Orange Bond
• Fluorescent Pink Bond
• Glossy Presentation
• Satin Presentation
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• Special Media 1 through Special Media 10: These options are used 
for customer-defined media types:

The following media options are not actual media types, but are used to 
specify a particular roll, tray, or manual feed. 

• Roll 1 through Roll 8
• Tray 1
• Tray 2
• Manual Feed: It is necessary to select this option to force manual 

feed.
• Mirror: Select whether or not to mirror the image.
• Data format: The actual image file format which is automatically detected 

when the file was added to the job grid. We recommend that you do not 
change this value.

For information on processing and printing TIFF files, see Appendix J - Tiff 
Helper.

• Scale: 

For AutoCAD DWG files enter either: 

• A valid AutoCAD scale (printed units = drawing units)

• FIT for automatic scaling, R1 through R5 for SETVAR values

• DIMSCALE to use the Dimension Entity Scaling for the drawing scale. 

For MicroStation DGN files enter either:

• A valid MicroStation scale (master units per inch)

• FIT to automatically scale to the Specified Size.

Scaling to FIT cannot be used when the Specified Size is set to Auto Detected.

• Title Block: Use this drop down list to specify where the title block is located 
on the selected image. If the location of the title block is irrelevant, select 
Don’t Care from the drop down list. Selecting a title block location is 
necessary when folding. 

Specified Size Tabbed Dialog Box 
The Specified Size tabbed dialog box is used to define custom (User Specified) 
values for the Specified Size field. When User Specified is selected for the 
Specified Size on the grid or on the Main tabbed dialog box, you must define 
custom values here.
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The Specified Size tabbed dialog box contains some or all of the following fields:
• Specified Size: When a size other than Auto Detected or User Specified is 

selected in this field, the following fields display in the Specified Size 
Settings box:

• Width: If User Specified is selected in the Specified Size field, the 
selected file’s width displays in this text box. If the width value is 
changed, Specified Size automatically changes to User Specified.

If the Specified Size field is set to User Specified, you must enter a value 
in the Width field.

• Height: If User Specified is selected in the Specified Size field, the 
selected file’s height displays in this text box. If the height value is 
changed, Specified Size automatically changes to User Specified.
If the Specified Size field is set to User Specified, you must enter a value 
in the Height field.
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• X Origin: This field is used to specify a horizontal coordinate for the 
image origin. By default, this field is set to 0. If you change the X Origin 
value, the Specified Size field changes to User Specified. This feature 
can be used, along with the Height and Width parameters to specify a 
portion of the original image.

You can also use the PlotWorks Image Viewer to specify a portion of the document 
to print. The Specified Size data is then automatically updated.

• Y Origin: This field is used to specify a vertical coordinate for the image 
origin. By default, this field is set to 0. If you change the Y Origin value, 
the Specified Size field changes to User Specified. This feature can be 
used, with the Height and Width parameters to specify a portion of the 
original image.

The default origin of an image is usually the lower left corner. However this can 
vary depending on the image format. For example, TIFF images consider the top 
left corner the origin. Therefore view the image in the Image Viewer to confirm 
the origin location.

Fig 4.12 
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• Bottom edge: Is used to select which edge of an image, as seen in the Image 
Viewer, should be considered the bottom. The selected edge becomes the 
bottom edge when the image is printed. The bottom edge=top and bottom 
edge=bottom settings apply to landscape-oriented images, while the bottom 
edge=left and bottom edge=right settings apply to portrait-oriented images.
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Fig 4.13 
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This represents the document as originally viewed in the Image Viewer

A1 Title
block

In the following diagrams the arrow indicates what side exits the printer first

A1

Bottom edge =Bottom

A1

Bottom edge = Top

A1 A1

Bottom edge = Left Bottom edge= Right

The Bottom edge option is useful when you plan to collate or fold scanned 
images and you want to make sure they all face the same direction. For 
example, the Bay folder requires the title block to enter the folder last in order 
to get a properly folded package. Other folders require the title block to enter 
the folder first. 

The diagrams below illustrate how the printed document is orientated 
depending upon the value selected for Bottom edge. Note where the title box 
ends up in each diagram. 
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Output Setup Tabbed Dialog Box 

Fig 4.14 
Output 

Setup 
tabbed di-

alog box

The Output Setup tabbed dialog box is used to define custom or User Specified 
values for the Output Size field. The following options are selected here:
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Output Size: From this drop list, select either one of the standard sizes or 
percentages offered. if you wish to specify a custom size, select User Specified 
and then enter values for Final height and Final width.
Scale by: Select whether to scale the selected image to a specific size (Final Size) 
or to a percentage of the original size (Percentage). Percentage values between 1 
and 1000 are accepted.

If the Output Size field is set to a standard size (A, A1, B, C, etc.), the Scale 
By field is automatically set to Final Size.

In addition to standard media sizes, you can select Auto-Standard to 
automatically print the image at 100% on the smallest standard sheet the complete 
image will fit on. Centering, margins, etc., will be implemented as normal for any 
given sheet size.

If the Output Size field is set to a standard percentage (75%, 100%, etc.), the 
Scale By field is automatically set to Percentage.
If the Output Size field is set to User Specified, you must select either Final 
Size or Percentage in the Scale By field. 

For best results when printing PostScript files, use Scale by Percentage and set a 
Scale that is a multiple of 100 (100%, 200%, 400% for example). This not only 
produces the desired printout, but prevents moire (those unsightly crosshatched 
patterns that show up when printing some PostScript files).

• Scale: is used to specify what percent to reduce or enlarge the original image 
when Scale By is set to Percentage.
If the Output Size field is set to a standard percentage (75%, 100%, etc.), the 
Scale field displays the correct value automatically.
If the Output Size field is set to User Specified, you must enter a percent 
value, between 1 and 1000, in the Scale field.

• Specify final media size: When Scale by: is set to Percentage, this check 
box is enabled. It is used to specify the media size the image should be printed 
on.

For example, if the specified size is A, and you scale the Output size by 
200%, but you want to print on a D-size sheet, specify the D size 
measurements for the width and height. Then the image will print at double 
an A-size, on a D-size sheet. This does not use up the whole sheet.

• Final width: Select the final, printed width of an image when the Scale By 
field is set to Final Size or percentage. If the Scale By field is set to Final Size, 
the image is scaled up to best fit the Final Width and Height.
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If the Output Size field is set to a standard size (A, A1, B, C, etc.), then the 
Final Width field displays the correct width automatically. If you change the 
width, the Output Size setting changes to User Specified.
If the Output Size field is set to User Specified, you must enter a value in the 
Final width field.

• Final height: Select the final, printed height of an image when the Scale By 
field is set to Final Size or percentage. If the Scale By field is set to Final Size, 
the image is scaled to best fit the Final Width and Height.
If the Output Size field is set to a standard size (A, A1, B, C, etc.), then the 
Width field displays the correct width automatically. If you change the width, 
the Output Size field changes to User Specified.
If the Output Size field is set to User Specified, you must enter a value in the 
Final height field.

• Scale Pens: When this check box is selected, pens on vector images are 
scaled when the image is scaled.

• Output Quality Levels: Select either Best, Normal, or Draft. These refer to 
device-specific or driver-specific quality levels. These options are used with 
Windows and Generic Embedded Controller printers, or when processing 
PostScript or PDF files. The quality level is used to determine the 
rasterization resolution to use for PostScript or PDF files, unless the 
resolution is set manually. See “Data Format tabbed dialog box” below for 
more information. 
Output quality is dependant on the printer. Best mode for a DesignJet printer 
is 600 dpi in Enhanced Graphics printing mode. Best on a laser printer may 
be 600 dpi without Enhanced Graphics mode. 

If your printer does not support multiple output resolutions, use caution when 
changing this value — the scale of the printed image can be affected.

Output quality values can also be changed in the Printer Interface. See 
“Configure Device-Specific Options” on page 8-15. 

Data Format Tabbed Dialog Box 
This tabbed dialog box contains file format information for the selected file. This 
information is automatically detected when the file is added to the job. 

Available data formats are:

• AutoCAD files (DWG, DXF, ACADM)
• HP-GL, HP-G/L2, 
• Generic Embedded Controller
• CalComp files (906/907)
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• TIFF and TIFF 5.5.1 (Subset of TIFF)
• CALS (Type 1)
• PostScript (Levels 1, 2, 3)
• CGM, DGN
• VRF (vector format only)
• PDF

• BMP, DCX, JPG, XIF, PCX, PGF, DXF
• VIC
• HPRTL
• DWF
• User Specified

The fields available depend on the Data Format detected.

Fig 4.15 
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Changing autodetected data can cause serious printing errors! We recommend 
that you not change the Data Format or Data Type settings on this tabbed dialog 
box .
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One or more of the following fields are used on the Data Format tabbed dialog 
box:
• Data format: Displays the detected file format 
• Data type: Used to select the actual type of data being used. 
• Origin (HP-GL only): Displays the origin (0, 0) of the HP-GL image: Center 

or Lower Left.
• Resolution: The print resolution of the image. 

For vector formats this refers to the coordinate resolution. 

ForPostscript, DWF, and PDF files, this option is only available when the 
“Base resolution on output size and quality check box” is not selected.

• Sync code (CalComp files only): The sync code notifies the printer that a 
print job is coming. Either one or two sync codes can be sent.

• End of message (CalComp files only): Notifies the printer that the end of the 
CalComp image has been sent.

• Checksum (CalComp files only): Verifies the integrity of the CalComp 
image.

• Enable Precheck Pass (AutoCAD files only): If this check box is selected, 
then PlotWorks performs the precheck pass done by DWG Direct, which 
looks for XREFs, ATTACHMENTS and FONTS.

• Print page range: For use with PostScript, TIFF, PDF, BMP, DCX, JPG, 
HP-GL/2, XIF, and PCX files. Allows you to specify which pages to print in 
multipage documents.

Select from two options, All or Pages. If All is selected, all pages are printed. 
If Pages is selected, specify a range in the form “xxx-yyy” (1-5, for example), 
or print only specific pages (1,3, 5-9, for example). If the page range is 
invalid, PlotWorks corrects it based on a valid range. 

• Base resolution on output size and quality: This option is selected by 
default to automatically determine the resolution for PostScript and PDF 
files. When selected, output quality is changed using the Output Quality 
Level option from the Output Setup tabbed dialog box.

If the output is still not right, set the resolution manually by unchecking this 
option and entering a resolution in the Resolution text box.

• Automatically add showpage: This option is selected by default for 
PostScript files. When selected the “showpage” command is either detected. 
or added automatically. Leave this box checked unless you get extra blank 
pages when printing, in which case uncheck it.

AutoCAD file options:

The Data Format sheet contains the following special options for AutoCAD files:
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• English or metric (ACAD/ACADM only): If the data type is ACAD, 
measurements are in English. If the data type is ACADM, Metric is 
selected.

Ensure the measurement units selected in the Job Editor match the ACAD drawing 
units.

• Remove hidden lines: This option is used during AutoCAD processing 
to remove lines behind other planes when 3-dimensional rendering.

• Reverse Z order: This option is only available with DWG Direct 
processing. Normally, PlotWorks prints the main AutoCAD image first, 
and any XREF files second. As a result, the XREFs are layered on top of 
the main image. When the Reverse Z order option is selected, the XREF 
files are printed first, making them appear as though they are underneath 
the main image. 

AutoCAD actually processes the XREFs as they occur in the DWG file. So your 
output using this option can still vary from those generated directly by AutoCAD.

• Scale: If an ACAD scale is selected from the Main tabbed dialog box or 
on the grid, that number displays here. You can also set the ACAD scale 
here and it will then display on the Main tabbed dialog box and on the 
grid.

• Plot by: Select this option to print the AutoCAD image by Extents, 
Display, Limits, View, or Layout. If View is selected, the View name 
field displays:
• View name: (AutoCAD) If Plot by View is selected, you can enter 

the name of the view to be printed. If Plot by Layout is selected, 
enter the name of the layout to be printed.

• View name: (DGN) Prints an area defined in MicroStation under a 
specified view name. If you select this Plot By option, you must 
enter the correct view name in the View Name field in the Job 
Editor. Allowable entries are:
•the saved view name in Microstation;
•the special view names of 1 through 8 (representing the allowable 
MicroStation view window numbers);
•a selection cell name in addition to a view name or number. For 
example: topview CELL<linepa> where topview is a name given 
to a view and linepa is a named cell.
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When printing DGN files, you can also specify a cell or shape specifications to 
restrict the view. For example, in the view name field: TOPSIDE 
CELL<PLOTME> would plot the view 'Topside' and further restrict the view to 
just the cell selection(s) called 'Plotme' within that view. To plot based upon 
shape(s), the following options are available: TOPSIDE SHAPE<level, color, 
style, weight>. If one of the settings is not used, you must enter '-1' as the value:  
TOPSIDE SHAPE<-1,255,-1,0>.

• Advanced button (DGN files only): This button brings up the DGN Ad-
vanced Options dialog box which lets you determine which DGN design 
elements are processed. For an explanation of each option, refer to your 
MicroStation manual. Grayed out options are not available. The check boxes 
for each entry on the new dialog box can have three values:

• Blank: Turn off these design element types and do not process them.

• Black check: Turn on these design elements and process them.

• Gray check (default): Use the setting for these design elements as orig-
inally saved in the design file view being processed.

 Plot by cell or Plot by shape normally allows you to specify the same cell multiple 
times on the same page, creating a “multi-page” printout. 

• Added RTL Raster Resolution: This drop down list appears if an HP-GL/2 
file is detected. In this case select a print resolution. Choices are:

• Auto

• 300 DPI

• 400 DPI

• 600 DPI
• Use drawings page size: This option appears if an HP-GL/2 file is detected. 

Select this check box to use the page size specified in the drawing.

DWF file options:

The following options display when DWF is selected for Data format:

• Data type: Used to select the actual type of data being used. 
• Resolution: The print resolution of the image. This option is only available 

when the “Base resolution on output size and quality check box” is not 
selected.

• Print page range: These fields display the current sheet number and the 
number of sheets in the DWF file. These values cannot be changed.
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• Base resolution on output size and quality: When selected, the output 
quality specified in the Output Setup tabbed dialog box is used.

If the output is still not right, set the resolution manually by unchecking this 
option and entering a resolution in the Resolution text box.

• Minimum Pen Width (Pixels): Select a minimum pen width in pixels. 
Increase the value in this text box if lines are not printing or are printing too 
light. When this value is changed, it is necessary to reprocess DWF files in 
the job grid.

Fig 4.16 
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Pens tabbed dialog box 
The Pens tabbed dialog box is used to define custom (User Specified) pen sets. 

The Pens tabbed dialog box contains the following fields: 
• Macro: This text box is used to enter a pen macro value. Pen macros control 

the color model used when a drawing is rasterized. There are three pen color 
models currently available:
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• Black and White: All colors (including white) are printed as black lines. 
Screens from 0% to 100% or patterns can be applied to any pen. 

• Gray: All colors are converted to the appropriate intensity and screened 
(greens are lightest, blues are darkest). Screens or patterns can still be 
applied. A screen will modify the intensity created from a selected color.

• Black and Red (Xerox MAX 200 and 8180 only): The red component 
of each color is separated along the red plane and a screen of the 
appropriate percentage is applied. Other colors are converted on the 
black plane and the appropriate gray intensity and screen is applied.

Fig 4.17 
Pens 
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The following pen macros are available:

Macro Effect

* Turns off sharpening for raster blocks and files.

~ Resamples all monochrome TIFF files. Reapplies patterns when 
scaling. Using this option may cause some thin lines in a line 
drawing to become dim or even disappear when the drawing is 
reduced in size. Using this option may prevent a TIFF from 
being used as a RED overlay on top of a main file printed in 
monochrome on the MAX 200.
Resampling all monochrome TIFF files dramatically increases 
computer processing requirements. This results in slower print-
ing. Slower computers or those containing less memory may 
freeze if this option is selected.

A Flattens all color pixels to solid black. Use this macro with color 
line drawing to print all lines solid black. Also when anchor 
points in the title block text are banded or when white lines 
appear in solid black text. Do not use this macro with photos as 
it will create solid black blocks. 

B Forces all pens to black resulting in a black and white mono-
chrome print. 
This is similar to the Repro Desk option “No flatten all vector 
pens to solid black.”
Forces monochrome output for vectors for DWF files. The ren-
dering type in PlotWorks is used to dither the grayscale and 
color images to monochrome.

C Use color definitions from the HP-GL/2 file instead of the pen 
set. This allows the drawing to get pen colors from the plot file.

E Fills pen strokes with patterns defined in the HP-GL/2 file 
instead of the pattern defined in the pen set. Drawing will use 
pen screens and patterns from the plot file.

F Enables the drawing to get fill screen and pattern information 
from the plot file. Polygons are then filled with patterns defined 
in the HP-GL/2 file instead of the pattern defined in the pen set.
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G Prints the grayscale representation of colors in HP-GL/2 files. 
Sets all vector pens to grayscale. 
When used with Repro Desk jobs, pen colors are mapped to a 
shaded halftone when Color is set to “No.”
Forces grayscale output from DWF files. The rendering type in 
PlotWorks is used to dither the image to monochrome. 

H Prints the entire image using the highlight color, if available. 
This is red on the XES MAX 200 or 8180. On the MAX 200 all 
vector pens and raster data will be printed red.

I Inverts the entire output sheet, including all overlays, watermarks, 
labels, and nested images. Inverts Generic Embedded Controller or 
RTL embedded data in HP-GL/2 files. Use this macro when the 
attached raster in a file is inverted (black is printing as white, etc.) or 
if the embedded raster file appears reversed. 
Selecting this macro has the same effect as selecting the "Negative" 
checkbox in Reprodesk pen sets. 

J Forces the use of the HP-GL/2 Plot Size ((PS) command) 
instead of the drawing's extents as specified by actual marks 
drawn on the page. 

K This macro is provided so that PlotWorks can emulate 
Reprodesk/Apprentice HP-GL/2 support. In particular, to ensure 
that:
• the Plot Size (PS) command landscape orientation imitates 

Reprodesk behavior
• Winding fill is used as the default polygon fill type for HP-

GL/2 files. 
• if a color is not defined in the HP-GL/2 file but the 'P' or 'C' 

pen macro is used, PlotWorks uses the color specified in the 
pen set. 
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M Enables printing in multiple colors on the XES MAX 200, 8180, 
Windows Color, and Generic Embedded Color Controller 
printers. This macro is necessary to print red components and full 
color. Note the following:

• Color printing on Windows and Generic Embedded 
Controller printers is only possible when printing HP-GL/2 
files using embedded pen values and the P macro which 
extracts color data from the internal file definitions. 

• Other vector file formats must have the pen definitions 
specified in the Pens tabbed dialog box. 

• Raster files can be printed entirely in red on the MAX 200 or 
8180 by setting pen 1 to color 6 in the Job Editor. 

• Forces color output from the DWF Tool Kit. 
• To print red and black representations of all colors with the 

Xerox MAX 200 or 8180, use the W, P, and M macros. 

N Ensures RTL raster data is not scaled to provide the same results 
as selecting the "Do NOT Scale RTL Raster Data" option in 
Reprodesk/Apprentice.

P Prints embedded patterns, types and specified opacity in HP-
GL/2 files. Provides the same functionality as specifying the 
macro combination of CFETV

Q Forces NOT using the RTL palette for monochrome raster 
blocks. The pen 0 and 1 in the RTL palette is instead used to 
determine the color of 0 and 1 pixels. 
This macro is provided for Reprodesk/Apprentice support as in 
Reprodesk, pen 1 is always set to black.

T Forces using merge control and transparency data from the HP-
GL2 file instead of from the pen set. The pen type and/or effect 
is taken from the plot file. 

V Allows the drawing to manipulate line ends (round, butt, square) 
from the file. The line end selection is taken from the HP-GL/2 
file not the pen set. This macro is not supported by Repro Desk. 

W Forces using pen widths defined in the HP-GL/2 or plot file 
instead of from the pen set. Prints embedded pen widths in HP-
GL/2 files
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The following macros control what type of dither or diffusion patterns are 
used for vector images. Printers that have good small dot printing 
characteristics will use the diffused dot dither by default

Macro Effect

D Use error diffusion dithering for vector parts of drawing. Forces 
order dot dither patterns to diffused dot dither patterns on the 
XEROX WIDE FORMAT 8830. 

O Forces ordered dot dither patterns. This macro overrides ran-
dom dot dither patters on the 8855, 8180 and KIP 3620. 
On Reprodesk jobs this macro ensures that vector areas in the 
drawing are rasterized using an ordered (pattern) dither.

.

The following macros control what type of dither or diffusion patterns are 
used for rastor images. For raster images, Error diffusion is the default. 

Macro Effect

R Forces diffused dithering.

Z Forces progressive pattern dithering.

When printing with embedded patterns, the output can differ depending on the 
printer used. This is because different devices have different resolutions. For 
example, a user-defined pattern created for the 650C at 300 dpi could end up 
condensed, reduced in size, on a 400 dpi printer. 

 The following two macros control image rotation, which is useful for forcing 

X Flattens all vector pens to a solid color on each color plane 
(black, black and red, or CMY). This provides the same result as 
when the "Map pen colors to a shaded halftone" check box is not 
checked in Reprodesk/Apprentice. Specify this macro when you 
don't want to map pen colors to a shaded halftone when Color is 
set to “Yes” in Reprodesk.

Y This macro is provided for Reprodesk/Apprentice support to 
ignore the fill type specified in the HP-GL/2 file and instead to 
use the alternate (even/odd) fill.
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prints into a particular orientation for folding 

Macro Effect

S Prints the short end first (portrait orientation). 

L Forces the a selected image to print landscape or long edge 
first.

Pen macros can be combined. For example, entering WP would enable 
printing both embedded pen widths and patterns.

For information on Repro Desk Pen Macros refer to Repro Desk Pen 
Properties and the PlotWorks Equivalent in Appendix G page 13.

Because the pen macro list is so extensive, PlotWorks now provides a more 
intuitive way to select pen macros from the Pen/Print Options tabbed dialog 
box. For more information see page 4-39.

We recommend using the minimum pen width (found in the drawing) for Fill 
Space values.

• Pen Grid: There are several columns in the pen grid. The first cell in the first 
column displays the measurement unit that measurements should be provided 
in.The rest of this column lists all the pens in numerical order. The rows 
represent properties for each pen. The following pen properties are provided 
in the pen columns:

• Width: Enter a pen width for each pen in this column. The default values 
are

• 13 if pen units are set to Mils
• 5 pixels if pen units are set to 400dpi 
• .32 if pen units are set to Millimeters.

• Shape: The Pen Shape field is used to select the line or vector end shape 
for HP-GL/2 files. This option is primarily for wide lines, where the end 
shape is readily apparent. The following choices are available:

 Round: This is the default value equivalent to the HP-GL/2 Round 
LA option.

 Square: This is equivalent to the HP-GL/2 Extended LA option.

 Butt: This is equivalent to the HP-GL/2 Butt LA option.
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 Extended butt :This is equivalent to the HP-GL/2 Square LA option.

The ‘HP-GL/2 internal LA command is ignored unless the ‘W’ pen macro is 
specified. If the ‘W’ pen macro is not specified, the line end shape is taken from 
the Pen Grid, not the HP-GL/2 file. If shape values are not entered in the Pen Grid 
and the W Pen Macro is not specified, the following warning displays: “Pen #1 
used but not defined.” In this case all lines default to the Round pen shape.

• Pattern: Enter a pattern number or a percent value (from 1 to 100%) to 
print diffused or ordered dot halftone patterns. If using a percentage, be 
sure to include a percent sign (%). Diffused dot patterns are not 
supported by all printing devices.

Pattern numbers are arbitrary. Refer to the Pen and Pattern sheet 
provided on the PlotWorks CD-ROM.

• Type: Specify a line type here. Click in this column to display the drop 
down list. The following choices are available:

• Opaque: This choice makes the line appear to be “on top” of any 
intersecting lines. An opaque line will hide any line beneath it at the 
point where the two cross. If more than one opaque line intersects, 
the last line drawn will be on top.

• Transparent: This is the default setting. This choice makes a line 
appear transparent when it intersects other lines. Black lines cannot 
be transparent. 

• Color: Enter a color number between 1 and 255. This column applies to 
color printers only. 

Once you have specified a pen set you can save it for future use. For more 
information see page: 4-61.

Pen/Print Options Tabbed Dialog Box
The Pen/Print Options Tabbed dialog box provides an intuitive method of 
selecting pen and print options. Some options that are available here can also be 
selected from the job grid or from the Pens tabbed dialog box. 

Using the Pens/Print Options Tabbed Dialog Box

Many options selected in this dialog box can be selected by specifying a macro. 
So if you know what macro you need, simply enter it in the Macro text box. 
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Options available from this dialog box are also set up in a select box that is 
organized in a tree view. Clicking on a plus (+) sign will expand that category of 
options. Clicking on the minus (-) sign will collapse that category of options. 
Clicking on an underlined item displays either a drop down list or a check box that 
you can select options from by double clicking. 

You can make these same selections using key board shortcuts:

• Right arrow: Expands a category
• Left arrow: Collapses a category
• Arrow up: Moves you up the list
• Arrow down: Moves you down the list
• Space bar: Selects or deselects a check box
• ALT + Arrow down: Expands a drop down list
• Enter: selects an option

When an option is selected from the tree view, its corresponding macro displays 
in the Macro text box.

Fig 4.18 
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Options Available from the Pens/Print Options Tabbed Dialog Box

The options available from this dialog box are divided into four main categories. 
These are: Pen Configurations, Processing Options, Print Options, and 
Rendering Options. 

Pen Configurations
These Pen Configuration options are provided so that you can choose to apply pen 
options specified in the HPGL2 file or from the pen set. The following pen 
configuration options are available:

• Pen Widths: 

• From File: Select this option to use pen widths defined in the HPGL2 
file. This is the same as selecting the W macro. 

• From Pen Set: Select this option to use the pen widths specified in the 
pen set.

• Pen Colors: 

• From File: Select this option to use pen colors defined in the HPGL2 
file. This is the same as selecting the C macro. 

• From Pen Set: Select this option to use the pen colors specified in the 
pen set.

• Polygon Fills: 

• From File: Select this option to fill polygons with patterns defined in the 
HPGL2 file. This is the same as selecting the F macro. 

• From Pen Set: Select this option to fill polygons with patterns specified 
in the pen set.

• Pen Strokes: 

• From File: Select this option to fill pen strokes with patterns defined in 
the HPGL2 file. This is the same as selecting the E macro. 

• From Pen Set: Select this option to fill pen strokes with patterns 
specified in the pen set.

• Transparency: 

• From File: Select this option to use merge control and transparency data 
defined in the HPGL2 file. This is the same as selecting the T macro. 

• From Pen Set: Select this option to use the Transparent or Opaque 
option as specified in the pen set.

• Line Ends: 



4-42 • PlotWorks User Guide 

• From File: Select this option to use the line ends defined in the HPGL2 
file. This is the same as selecting the V macro. 

• From Pen Set: Select this option to use the line ends specified in the pen 
set.

Processing Options
The following processing options are available:

• HPGL2 Plot Size: 

• From File: Select this option to use the page size specified in the 
drawing. This is the same as selecting the Use drawings Page Size check 
box. This is the same as selecting the J macro.

• Extents: Select this option to use the image extents.
• Repro Desk Emulation: 

• Yes: Select this option if you want your print output to match Repro 
Desk print output. This is the same as selecting the K macro. When Yes 
is selected:

• HPGL2 files are not rotated when the plot size is set as portrait
• Winding fill is used for all polygon fills instead of the type specified 

in the HPGL2 file. 
• If a color is not defined in the HPGL2 file and the 'P' or 'C' pen macro 

is used, the color specified in the pen set is applied.

• No: Select this option if you do not want your print output to match 
Repro Desk print output. 

• Alternate VIC Merge Control

• Yes: Different versions of VIC files merge transparency differently.This 
option is provided to resolve this issue. Select Yes if your VIC file is not 
printing as expected. This is the same as selecting the ^ macro.

• No: Select this option if your VIC files are printing just fine. 
• Scale RTL Raster Blocks: This option is provided to match a function 

available in Repro Desk.

• Yes: Repro Desk compensates for differences in resolution by 
sometimes scaling RTL images. Select Yes if a printed image from a 
Repro Desk job does not seem to be properly rendered. This is the same 
as selecting the N macro.

• No: Select this option if your files are printing just fine. 
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• Use RTL Pallet for Monochrome: This option is provided to print 
monochrome raster blocks the same way that Repro Desk does.

• Yes: Select this option to use the RTL palette to determine the color of 
Pens 0 and 1. This is the same as selecting the Q macro.

• No: Select this option to set pen 1 as black as is done in Repro Desk. 
• Error-Free Plotting: When a specified size is selected for printing and the 

extents of the drawing are over or under such that the image will be clipped, 
PlotWorks compensates if the amount that will be clipped is within the 
amount specified in the Size Tolerance Sheet (see page  4-75). However this 
causes problems with some jobs that are imported from Repro Desk.

• Yes: Select this option if your Repro Desk jobs are printing just fine. This 
is the same as selecting the % macro.

• No: Select this option if an image from a Repro Desk job disappears off 
the page or is clipped.

• Process PS/PDF/DWF files in Color: Select Yes if your printer is capable 
in printing in more that one color. This is the same is selecting the M macro

Print Options: The only print option available here is Print Orientation. Select 
from one of the following:

• Auto Rotate: Select this option to rotate the image such that the least 
amount of media is used.

• Long Edge: Select this option to print the image oriented landscape or 
long edge first. This is the same as specifying the L macro.

• Short Edge: Select this option to print the image oriented portrait or 
short edge first. This is the same as specifying the S macro.

Rendering Options: Rendering Options are subdivided into Color Model and 
Rendering Options and Advanced options. 

Color Model and Rendering Options: 
• Color Model: Select what color model to use from the following options:

• Printer Default: Select this option to print in gray scale on black and 
white printers and color on color printers.

• Grayscale: Select this option to print all vector pens and HP-GL/2 files 
in grayscale. When used with Repro Desk jobs, pen colors are mapped to 
a shaded halftone when Color is set to “No”. This is the same as selecting 
the G Pen Macro.
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• All Black: Select this option to print all pens as black resulting in a black 
and white monochrome print. This is similar to the Repro Desk option 
“No flatten all vector pens to solid black.” This is the same as selecting 
the B Pen Macro.

• Print Image in Highlight Color: Select Yes if your printer can print in a 
different color (such as the MAX 200) and you want to print in two colors. 
This is the same as selecting the H Pen Macro

• Allow Color if Available: Select Yes if your printer can print in color. This 
is the same as selecting the M Pen Macro

• Vector Rendering: Options selected here can also be selected from the 
Vector Imaging tabbed dialog box of the Printer Interface. For more 
information see page 8-35 of this user guide. The following options are 
available here:

• Printer Default: Uses the rendering method selected in the Printer 
Interface.

• Diffused: When Diffused is selected, dots are placed to approximate 
source pixels . The amount of "error" in the approximation is balanced 
with adjoining source pixels to better approximate the source image. 

This option is ideal when printing a continuous gradient from black to 
white or printing line drawings.

This type of dithering is applied when the Repro Desk option “Use Error 
Diffusion for Gray or Color RTL images” check box is selected.

This option provides the same functionality as specifying the R macro.

• Ordered: When Ordered is selected, dots are placed in a regular pattern 
to approximate the source pixel. A lighter source pixel is mapped to a 
pattern containing fewer pixels, while a dense pattern is applied for dark 
pixels. This is the default option for color and RTL printers. This option 
is ideal:

• When printing in color
• When printing drawings that contain fills
• When printing photos.
• When printing using the Océ 9800 series of printers.
• When you want print output to resemble output from the Océ 9800 

printers
• This option provides the same functionality as specifying the Z 

macro.
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• Reduce Coverage: This option is mainly used with the 8845 printer. 
This is the same as selecting the U macro.

• Raster Rendering: Options selected here can also be selected from the 
Raster Imaging tabbed dialog box of the Printer Interface. For more 
information see page 8-35 of this user guide. The following options are 
available here:

• Printer Default: Uses the rendering method selected in the Printer 
Interface.

• Diffused: When Diffused is selected, dots are placed to approximate 
source pixels . The amount of "error" in the approximation is balanced 
with adjoining source pixels to better approximate the source image. 

This option is ideal when printing a continuous gradient from black to 
white or printing line drawings.

This type of dithering is applied when the Repro Desk option “Use Error 
Diffusion for Gray or Color RTL images” check box is selected.

This option provides the same functionality as specifying the R macro.

• Ordered: When Ordered is selected, dots are placed in a regular pattern 
to approximate the source pixel. A lighter source pixel is mapped to a 
pattern containing fewer pixels, while a dense pattern is applied for dark 
pixels. This is the default option for color and RTL printers. Ordered 
Dither is also automatically applied when a Repro Desk job is imported 
into PlotWorks and the “Use Error Diffusion for Gray or Color RTL 
images” check box is not selected in Repro Desk. This option is ideal:

• When printing in color
• When printing drawings that contain fills
• When printing photos.
• For printing output similar to Repro Desk raster output when the 

Repro Desk option “Use Error Diffusion for Gray or Color RTL 
images” check box is not selected. In this case select Ordered Dither 
from the Raster Imaging tabbed dialog box. 

• When printing using the Océ 9800 series of printers.
• When you want print output to resemble output from the Océ 9800 

printers
• This option provides the same functionality as specifying the Z 

macro.
• Ordered Pattern Set: Options are:
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• Printer Default: Select this option to use the default Pattern Set used by 
the Printer Interface.

• Normal: Select this option to use the 64 Gray Level Order Dither Pattern 
Set

• High-Res: Select this option to use the 256 Gray Level Order Dither 
Patterns. 

Advanced Options: Options are:
• Invert: Select Yes to print image colors inverted. This is the same as 

selecting the I macro.
• Make Raster Pixels Solid Black: Select Yes to print raster pixels solid 

black.This is the same as selecting the A macro.
• Force Pens Solid on all Planes: Select Yes to print all vector pens a solid 

color in each color plane, black, black and red, or CMY. This produces the 
same effect as when "Map pen colors to a shaded halftone" is not selected in 
Repro Desk. This is the same as selecting the X macro.

• Force Even/Odd Polygon Fill: Select Yes to use alternate or even/odd fills 
instead of the fill type specified in the HPGL2 file. This option is provided for 
Repro Desk support. This is the same as selecting the Y macro.

• Resample All Monochrome TIFF: Select Yes if you are printing:

• Monochrome TIFF files, aerial photos, gray scale images, or scanned 
images and you want to improve print quality.

• A portion of a monochrome TIFF file or a scanned image. 

• A monochrome TIFF file or a scanned image that is resized.

This is the same as selecting the ~ Macro.

Resampling all monochrome TIFF files dramatically increases computer 
processing requirements. This results in slower printing. Slower computers or 
those containing less memory may freeze if this option is selected.

• Sharpen Raster Blocks: Select Yes to print raster images crisper when 
scaling.

Overlays Tabbed Dialog Box 
This tabbed dialog box is used to apply and position overlays. Typical overlays 
include placing a title block, logo, or an approval stamp over an image. You can 
layer up to ten images on top of a base print. 
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Fig 4.19 
Sample 

image with 
an overlay

Overlay  
image

Overlaying Images

For best results when applying overlays, make the overlays relative to the main 
image. Then if the base image is mirrored, enlarged or reduced the overlay is 
adjusted accordingly.

Making overlays relative to the main image:
1. From the Setup menu, click Preferences.
2. Click the Finishing Options tab.

3. Select the Make overlays relative to main image check box.

Overlays and base files must reside in the same directory.

Printing images with overlays:

1. Add your base and overlay images to the job ticket using the Add Files 
button. 
If you want to use a file as an overlay and print the file individually, you must 
add that file to the job grid twice.

PlotWorks supports the Windows “drag-and-drop” method of adding files. 
Simply drag the image files from the Windows Explorer window and drop them 
onto the Job Editor grid.

2. Set the quantity to X or 0 in the Qty (quantity) cell for each image that will 
be used as an overlay. 

3. Select the base image by clicking on its row number on the grid.

4. Enter a quantity of 1 or more for the base image.
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5. Click on the Properties button from the Job Editor tool bar to open the Detail 
Property Sheet.

6. Click on the Overlays tab.

Fig 4.20 
The Over-

lays 
tabbed di-

alog box 
displaying 
the second 

filename 
drop down 

list

7. You can overlay up to 10 files on the base image. Click on the first Filename 
drop down list and select the first file to use as an overlay. If you want to 
overlay a second file select it from the second Filename drop down list and 
so on.

If the file you wish to use as an overlay does not display in the drop down list, 
ensure it is listed in the job grid and that it is assigned a Quantity of X

8. Position the overlay by entering an X and Y offset in the provided text boxes. 
Drawings are overlaid, by default, on the lower left corners. 

• X Pos: Enter the X coordinate for the origin of the overlay image 
(horizontal). 
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• Y Pos: Enter the Y coordinate for the origin of the overlay image 
(vertical). 

For an example of X and Y coordinates, please see the diagram “The default 
location of the X and Y origins” on page 4-23.

9. Repeat steps 7 and 8 for the next file to use as an overlay by selecting it from 
the second Filename drop down list and assigning it an X and Y coordinate. 
Repeat as necessary.

10. Save the job ticket and output the job to the printer. The overlay image(s) will 
print on the main image file.

Watermarks Tabbed Dialog Box 
A watermark is usually a light line of text printed under the main file. A water-
mark is usually text such as Preliminary, Not for Construction, or a name. Below 
is an example of a watermark. 

Fig 4.21 
Sample 

image with 
a water-

mark

You can select the font, pattern number or percentage, and the position of the 
watermark.

To create a watermark:

1. Select a file in the job grid that you want to add the watermark to.
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2. Click the Watermarks tab on the Detail Property Sheet.

Fig 4.22 
The Water-

marks 
tabbed di-

alog box

3. Select the desired Watermark Direction by selecting one of the buttons 
provided. These buttons determine the direction the watermark prints across 
the page:

Lower left to upper right

Upper left to lower right

Top to bottom
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Watermarks are always scaled to fit the page centered in the direction selected

4. Enter up to 80 alphanumeric characters, to make up the watermark, in the 
Watermark Text box. Special characters like ASCII characters entered from 
the numeric keypad or CR/LF are not supported.

5. Click the Font... button to display the Font dialog box.

Fig 4.23 
The Font 

dialog box

PlotWorks currently supports Windows system fonts only. Other True Type fonts 
are not supported at this time.

6. Select a font, style, and size for the watermark. Ensure that the selected font 
is available on the PlotWorks Server or the desired output may not be 
achieved. 

7. Next select a pen color if you are printing to a color printer. Otherwise the 
default pen color (black) is used. 

Left to right
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8. Select a pen pattern by entering a pattern number or percentage. If specifying 
a percentage include the percent symbol (%). Refer to the Pen and Pattern 
charts provided on the PlotWorks CD-ROM to select a pattern. 

To print a watermark or label in red on HPGL/2, HPGL-RTL, PDF or PostScript 
files it is necessary to apply the "M" Pen Macro. For more information see page 
4-32

9. Click OK to return to the Watermarks tabbed dialog box . 

The text specified for the watermark displays in the watermark column of the job 
grid. You can save the watermark for future use. For more information see page  
4-61.

Margins Tabbed Dialog Box 

Fig 4.24 
The 

Margins 
tabbed di-

alog box

The Margins tabbed dialog box is used to apply and adjust margins and position 
the image file on the medium. 
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Setting Margins and Justifications

1. Click on the Margins tab on the Detail Property Sheet.
2. Justification: Select the desired justification for the printed image by 

clicking on the appropriate button. Choices are:

Upper left Top center Upper right

Center left Center Center right

Lower left Bottom center Lower right

Top refers to the top of the actual image and the leading edge of the printed image.

3. Margins are measured in the selected units (inches, centimeters, or 
millimeters). Add a Top, Bottom, Left or Right margin by entering the 
desired margin width in the provided text boxes.

4. Select the Finishing margin check box to add a finishing margin (for 
binding) on the left side of the medium. This activates the Finishing margin 
text box. Enter the desired width for the finishing margin. This width is added 
to the extent of the image plus any edge margins set. 

Once margin specifications are selected, they can be saved for future use. For 
more information see page  4-61.

Margins and scaling

The final media size is affected when applying margins depending on the scaling 
type selected. 

• Percent scaling: If scaling to a percentage, the image itself will be the exact 
percent scale specified and the margins are added to it. If scaling to 75%, with 
1” margins selected all around, the final print size will be the image shrunk to 
75% of its original size and will have an inch margin all the way around.
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• Final size scaling: If scaling to a final size, the image is scaled down to a size 
that equals the final size minus any margins. For example, if scaling to a final 
size of 36 x 24 with 1" margins, the image extents will be 34 x 22, printed on 
36 x 24 media. Margins are subtracted from the actual final media size and 
the image prints on the remaining media, thus reducing the final “image size.”

Fig 4.25 
(A) Scale 

to Percent 
(B) Scale 

to Final 
Size

75%
 scale

A.

1.0"

1 inch margins all around -
media selected based on
scale size plus margins

B.

1.0"

1 inch margins all around -
image scaled to fit inside 
area left after margins

24"

36"

Examples of different margin settings

Fig 4.26 
Image 

printed 
with no 
margin 

specified
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The outlined blue rectangle in the image above, represents the image extent. Note 
how the image is centered on the media.
Setting margins increases the width and length of the image.

Fig 4.27 
Illustra-
tion of a 

image 
printed 

with a.5 
margin set 

on all 
sides.

Fig 4.28 
Image 

printed 
with top-

center jus-
tification 

The image 
is centered 

horizon- 
tally, but is 
positioned 
at the top 

of the page
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.This example below shows how a finishing margin is applied to the left side of 
the image. Notice that the width of the finishing margin is added to the overall 
image size.

Fig 4.29 
Image with 

margins 
set to .5 

and finish-
ing mar-

gin set 
to 1.0 . 

Notice that the image below, which is upper-right justified, is cropped. The .5” 
margins plus the 1.0” finishing margin, in addition to the justification, cause the 
image to be larger than the actual medium. Change the Output Size or Specified 
Size, or select larger media. and try again.
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Fig 4.30 
Image with 

margins, 
finishing 
margin, 

and justifi-
cation ap-

plied on 
medium 

that is too 
small.

Margins and justification are only applied if the Specified Size, which includes the 
image extents, plus margins, plus the finishing margin is smaller than the final 
Output Size (the actual medium) selected.
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Labels Tabbed Dialog Box

Fig 4.31 
The 

Labels 
tabbed di-

alog box

This tabbed dialog box is used to create and apply a single line text label. You can 
select the label font, style size, and position. You can also select a pen and pattern 
for the label.

Fig 4.32 
Label 

samples

Default label is applied to the
lower-left edge of media.

Rotation is applied relative to the
lower left corner of the label.
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To create a label:

1. Click on the Labels tab of the Detail Property Sheet.
2. To offset the label from its starting point, the lower-left edge of the medium, 

enter the desired offset amount in the X Pos and Y Pos fields.

• X Pos: X’ refers to the horizontal axis. Entering a positive number shifts 
the X position to the right while a negative one shifts the X position to 
the left. 

• ‘Y Pos: Y’ refers to the vertical axis. A positive number here shifts the 
Y position up, a negative number shifts it down

‘Entering a number larger than the actual medium size causes the label to snap to 
the edge of the medium. This is an easy way to offset the label to the opposite side 
of the medium. See example below.

Fig 4.33 
Label lo-

cation

Label

Large X value

Label

Large Y value

Label

Large X &Y value

3. Label rotation is applied so that the label is never cut off. Select the desired 
degree of rotation relative to the lower-left corner of the label by clicking on 
one of the Label Rotation radio buttons. Choices are: 0, 90, 180, and 270.

Fig 4.34 
Label rota-

tion

4. Enter content for the label by either entering text in the Labels text box or use 
the Label macros.

• Label macros: These are predefined macros that are used to enter 
commonly used information for labels. These macros can be combined 
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with other label macros or any other text specified. The following label 
macros are available:

• Date: Adds the current date in month/day/year format.
• Time: Adds the current time in hour/minute/second format
• Filename: Adds the file name.
• Job: Adds the job name
• Set: Adds the number of print sets requested
• Image: Adds the image number as per the job grid. This is useful for 

troubleshooting purposes.

Click a Label macro button to enter the selected macro. The macro name, 
enclosed in square brackets ( [Date] ), will display in the Label text box. 
as shown on the screen shot on page 4-58.

• Label text: Enter up to 255 text characters for the label in this text box. 
If a label macro was also selected, it will appear in this text box as well. 
You can enter text of your choice before, or after each macro. This label 
data will appear in a single line when printed. 

5. The Label group box displays the font style, type, size, color and pattern 
currently selected. To change any of these options, click on the Font button 
to open the Font dialog box.

• Select a font, style, and size for the label. Ensure that the selected font is 
available on the computer and is a Windows system font. Other True 
Type fonts are not supported.

• Next select a pen color if printing to a color printer. Otherwise the default 
pen color (black) is used. 

HPGL/2, HPGL-RTL, PDF and PostScript files will not print Watermarks or 
Labels in red unless the "M" Pen Macro is specified. 

• Select a pen pattern by entering a pattern number or percentage. If 
specifying a percentage include the percent symbol (%). Refer to the Pen 
and Pattern charts provided on the PlotWorks CD-ROM to select a 
pattern. 

6. Click OK to return to the Labels tabbed dialog box. 

You can save configured labels for future use. For more information see page  4-
61
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Saving and applying options selected from the 
Detail Property Sheet
Saving and applying a Pen Set
You can save the pen sets you create in the Job Editor for later use in the same job 
ticket or in other job tickets.

To create and save a pen set:

1. Select the image from which you want to save the pen set, or open the Pens 
tabbed dialog box and create the desired pen set.

2. Open the File menu and select Save Pen Set.
3. Enter a name for the pen set. The Job Editor automatically adds a .PEN 

filename extension.
4. Select a directory in which to save your pen set and click on Save.

See also: “The Detail Property Sheet” on page 4-16.

Open an Existing Pen Set

You can create and save your own reusable pen sets in the Job Editor or Client. 
Once saved, pen sets are available for reuse in the same or other job tickets.

To apply a pen set to an image in a job ticket:
1. Select the image to which you want to apply the pen set. The Job Editor does 

not allow multiple selections for this command, but by applying it to the 
prototype you can cause all files added thereafter to take on that pen set.

2. Open the File menu and select Open Pen Set.
3. Select the appropriate pen set.
4. Click Open. The selected pen set replaces the existing pen values.

Saving and applying watermark, margin and label settings
Saving a watermark, margin or label setting

Once you have specified a watermark, margin or label from the Detailed Property 
Sheet, you can save the watermark, margin or label to use again. To do so:

1. Click on the File menu
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Fig 4.35 
The 

Templates 
menu 

options

2. Select Templates... 

3. Click on either Save Watermark, Save Margin, or Save Label depending 
on what you are saving. The Save As dialog box opens. 

4. From the Save in drop down list, select the directory you wish to save the 
configuration in. 

5. Type a name for the configuration in the File name text box.

6. Click on the Save button. 
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Fig 4.36 
The 

Save As di-
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Applying a Saved Watermark, Margin or Label

Once a watermark, margin or label is saved, you can apply it to any image. To do 
so:

1. Select the image you want to apply the configuration to from the job grid.
2. Click on the File menu

3. Click on Templates...

4. Select Open Watermark, Open Margin, or Open Label. The Open dialog 
box opens.

5. From the Look in drop down list, select the directory the configuration is 
saved in. 

6. Double click on the saved configuration. The watermark, margin or label is 
applied to the selected file.
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The Scale View
The Scale View is a diagram available from the View menu. 

Fig 4.37 
Scale View

This window provides a visual representation of several printing parameters 
including:

• Size: A “before and after” comparison of specified size and output size.
• Scale: The percent of reduction or enlargement between the Specified and 

Output size.
• Media type: The color of the Output Size representation reflects the media 

type selected. Gray represents vellum, white represents bond, blue represents 
film, green represents T-bond, and red represents none.

• Quantity: The Output Size diagram shows the number of copies requested, 
up to three. If the quantity is greater than three, the bottom copy shown on the 
diagram is outlined with a dotted line.

• Mirroring: When the mirroring option is selected, the word “MIRROR” or 
the letters “MR” appear on the Specified Size diagram. The same letters 
appear reversed on the Output Size diagram.

The Scale View can be positioned anywhere on the desktop. Click and hold the 
mouse on the title bar of the Scale View window and drag it to the desired loca-
tion. To close the Scale View, either select it again from the View menu or click 
on the square box in the upper-right corner of the Scale View window
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Setting Preferences
The Preferences dialog box is used to set job-wide preferences and record 
administrative data for the job ticket. 

To set preferences:

1. Open the Setup menu and select Preferences.
2. Select a tab window by clicking on its tab.

3. Edit the fields as desired.

4. Click OK. If you wish to save this particular configuration for later use, select 
Save Configuration from the File menu. The information is saved to your 
configuration file (conf.plp) and used as the default for later job tickets that 
you create.

The Preferences dialog box contains the General, User Information, Finishing 
Options, and Nesting Options tab windows. These are described on the following 
pages.

General Preferences tabbed dialog box
The General Preferences tabbed dialog box contains the following options:
• Size units: Select the units of measure for use.
• Pens: Select the units of measure for pen values.
• Default number of sets to request: Enter the default number of sets to 

request when you output a job. This number can also be set in the Output Job 
dialog box. 

• Default file paths group box: Options here specify the default directory for 
common functions

• Open jobs: From this drop down list select a default directory to open 
jobs from. Choices available are: 

• from the specified job path; Selecting this option activates the 
Browse button below it. Click this button to browse and select a 
default directory to open jobs from.

• from last path used to open/save jobs; When this option is 
selected, the last directory used to open jobs from or save jobs too is 
opened.

• from the last path used to add files; 
• from the current working directory.
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Fig 4.38 
General 

tab of the 
Preferen-

ces tabbed 
dialog box

• Add Files: Use this drop down list to select a default directory to add 
files from. Choices available are: 

• from the specified job path; Selecting this option activates the 
Browse button below it. Click this button to browse and select a 
default directory to add files from

• from last path used to open/save jobs; 
• from the last path used to add files; 
• from the current working directory. 

• Scan Files: This drop down list is used to select a directory to place 
scanned image files into when the Scanner Interface is opened from the 
Job Editor. Choices available are:
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• to specified scan path; Selecting this option activates the Browse 
button below it. Click this button to browse and select a directory to 
place scanned files too. 

• to the last path used to open/save jobs; 
• to the last path used to add files; 
• to the current working directory. 

User Information Tabbed Dialog Box
The User Information tabbed dialog box is used to specify administrative 
information that can be used for job tracking and accounting with the Advanced 
Reporting Utility (ARU). For more information on the ARU, see Chapter 10. This 
information is also included in job information (.INF) files, which are used to send 
additional information and instructions along with your print job. For further 
information on .INF files, see “Send a Special Instruction File” on page 4-67. 

Fig 4.39 
User 

Information
tab of the 

Preferenc-
es dialog 

box
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All fields are limited to 405 characters. 
The Company, Project, Contact, and Comment fields are used when the job is 
output directly to a Job Queue to identify the job origination and provide 
additional information. The Company and Project information is displayed in the 
Job Queue’s Description field. The Contact information shows up in the Job 
Queue’s Submitted by field, after the computer name and user name (for the 
above example: \\computer\user: Customer Support).
The computer name and user name can also be used by the Job Processor and 
Printer Interface to send processing error information and/or print confirmation if 
those options are enabled. 

Finishing Options 

Fig 4.40 
Finishing 

Options 
tab
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The Finishing Options tabbed dialog box is used to set folding and finishing 
parameters, to remove borders from images and reverse printing orders. See 
Chapter 11 - Folder Information. for more information.

The Finishing Options tabbed dialog box contains the following fields:

• Folding User Interface: Use this drop-down list to select device specific 
folding options. Choices are: 

• Default: Select this option if you are not running a MAX 200 NACO or 
EO or a GFI folding device.

• MAX 200 NACO

• MAX 200 EO. 

• GFI Folder

Depending on what item is selected here, this tab window changes to display 
folder specific options. Chapter 11 - Folder Information, provides more 
information on folders.

• Enable fold: Select this box to enable a folder. Be sure the folder you are 
using is supported. You must select this box to enable other folding options.

• Width: Enter the fold width for the first fold in this text box. The 
measurement units specified on the General preferences sheet is used. 

• Add fold margin: Select this check box to enable a fold margin and to enable 
the Punch and Reinforce options.

• Margin: Enter the desired fold margin width in the measurement units 
selected from the General Preferences sheet.

• Cross-fold: Select this check box to enable cross folding.
• Punch: Select this check box to enable hole punching. Select the Add fold 

margin check box to enable this option.
• Reinforce: Select this check box to add reinforcing strips to the margin. 

Select the Add fold margin check box to enable this option.
• Tab: This feature is currently unavailable.
• Finishing macro: Finishing macros are used to simplify sending special 

commands to the printer and/or folder. Additional information on folders and 
macros is provided in Chapter 11. 

• Remove borders from prints: Select this check box to remove trim line 
borders from prints.

The Reverse Standard Print Order option is generally used with printers that 
output sheets facedown. In this case, the first image listed in the job ticket winds 
up at the end of the set. If you reverse the print order, the first image listed in the 
job ticket ends up at the beginning of the set.
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• Make overlays relative to main image: Select this check box to scale or 
rotate overlays in relation to the main image.

Nesting Options Tab
Nesting enables printing several images on one piece of medium to prevent media 
waste. For example, if D-size media is loaded, you can nest two C-size images so 
that they print side by side on D-size media. 

The Job Editor select the medium that it can print most drawings on by default. If 
more than one media available allows the same number of drawings, the Job 
Editor uses the one that wastes the least media.

Fig 4.41 
Example of 

a nested 
print job “A” size

“B” size image
2 images nested on 
“C” sized mediaimage

To nest images:

1. Open the Setup menu.
2. Select Preferences. 

3. Click on the Nesting Options tab. 

4. Select Enable nesting.

5. Enter the Maximum images to nest (up to 100). This specifies when to start 
a new nested job. The default maximum nest length is 36 inches. To change 
this value, see page  8-19.

6. In the Border between nested images field, enter the amount of margin 
space you want between nested images.

7. Click OK. 
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Fig 4.42 
The 

Nesting 
Options 

tabbed di-
alog box

About Nesting

Only drawings in the same job and set can be nested together. This keeps different 
jobs and sets separate.

All drawings in each nest are oriented the same way, depending on what allows 
more drawings and saves media. Drawings are placed across the width of the roll 
until no more fit (we call this “one stack”). Then the position of the next stack 
starts just below the previous one.

By default, the Job Editor will use the media entry allowing the most drawings. 
This does not always use the least media, however. For instance, if three 18"x12" 
drawings are printing on a 24" roll there will be an empty space of 18"x12" 
because the drawings do not nest evenly.
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On a color printer, it is possible to have both color and black and white drawings 
in a job. It can be disadvantageous to nest these because the color prints take more 
time and use more memory. 

Media Override on Nested Jobs
Use media override and the Printer Interface (at the service bureau or print server) 
re-nests the drawings to the best fit on the selected medium. The Printer Interface 
selects the paper size based on the first image in a group to be nested. If the first 
image is smaller than the following ones, clipping can occur.
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Processing Options
The Processing Options tabbed dialog box is used to select how to process 
AutoCAD files, deal with processing errors, and what to do with files after 
processing.

To set processing options:

1. Click on the Setup menu
2. Select Processing Options. 

3. Click on the appropriate tab.

4. Edit the fields as desired.

5. Click OK. The information is saved and used as the default for future job 
tickets.

The Processing Options dialog box contains the Processing, Size Tolerances, and 
AutoCAD/DWG Direct Setup tabbed dialog boxes. These are described below:

Processing tabbed dialog box
The Job Editor saves processed images in a special file format called Performance 
Graphics Standard (PGS). Options selected from the Processing tabbed dialog box 
determines what to do with the PGS files when a job is outputted. 

Do not store archived files in the same directory as a PGS file! The Job Editor 
deletes files in the directory where PGS files are created. If files are stored in the 
same directory as a PGS file, if one of those files is added to the Job Editor, when 
the Job Editor is next closed all files in that folder, except for the PGS files, are 
deleted. 
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Fig 4.43 
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The following options are available from the Processing tabbed dialog box:

• Send PGS files only: When this option is selected, the Job Editor sends only 
the processed files to the output destination. The original image files are not 
sent.

• Send original image files only: When this option is selected, the Job Editor 
sends only the original image files to the output destination. The processed 
files are not sent. The Job Processor must be open and started to process these 
jobs.

• Send both PGS and original image files: When this option is selected, the 
Job Editor sends both the processed files and the original image files to the 
output destination.

Files transferred via FTP do not maintain their current date and time stamps. 
Therefore, Send original image files only or Send PGS files only are the only 
options available when FTP is the selected destination.

• In directory: Select this radio button to specify an existing directory to put 
processed files in. Please note that if this option is selected, no files should be 
stored in the same directory where the processing takes place as all files in 
this folder are deleted when the Job Editor is closed.
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• Below PLP file: Puts the processed files in a subdirectory within the 
directory containing the job ticket. This selection assumes that a directory 
called Preproc already exists in this location. If you do not have a Preproc 
directory, select the Automatically create preprocessing subdirectory 
option to have the Job Editor create it for you.

• Automatically create preprocessing subdirectory: When this option is 
selected, the Job Editor creates a Preproc subdirectory within the directory 
containing your job ticket when the images are processed.

Size Tolerances Sheet
This sheet lets you specify a range of error within which Error Free Printing (EFP) 
corrects size and origin problems automatically on images submitted with an 
incorrect specified size. If a discrepancy exceeds the allowable range, the Job 
Editor warns the operator that attention is required before printing.

If you submit an image using Auto Detected for the Specified size, the Size 
tolerances are not used.

Fig 4.44 
Size 
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The following fields appear on the Size Tolerances sheet:

• Oversize %: The allowable percentage that the ACTUAL size can be greater 
than the SPECIFIED size.

• Undersize %: The allowable percentage that the ACTUAL size can be less 
than the SPECIFIED size.

• Offset origin %: The allowable percentage that the ACTUAL origin can be 
offset while the size is within over/under size limits.
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• Big offset origin size %: Compensates for printing specifications that are 
both offset origin and slightly over or undersized. As long as an image is 
within this amount of the specified size (over or under), then it will be printed 
regardless of how far off-origin it might be. 

AutoCAD/DWG Direct Setup Sheet
The AutoCAD/DWG Direct Setup sheet tells the Job Editor how to do AutoCAD 
file processing. If you are not printing AutoCAD images, skip this part. For more 
information on processing AutoCAD files, please see Processing AutoCAD Jobs 
in Appendix H.

Fig 4.45 
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The following fields appear on the AutoCAD / DWG Direct Setup sheet:
• Drawing is over-sized by percentage: Enter an allowable error range for the 

specified print size. If an error is within this range, the Job Editor corrects it 
automatically and continues processing the AutoCAD file. When an error 
exceeds this range, the Job Editor requests operator attention.

• Drawing is under-sized by percentage: Enter an allowable error range for 
the specified print size. If an error is within the acceptable range, the Job 
Editor corrects it automatically and continues processing the AutoCAD file. 
When an error exceeds this range, the Job Editor requests operator attention.

• AutoCAD path: Enter the full path and filename of your AutoCAD 
executable.

• Font search path: Enter the full path/name of the directory that contains the 
AutoCAD font (.SHX) files used in the job.
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• Substitute font: Enter the path/name of the substitute font to be used when a 
specified font is not available.

• Use DWG Direct: Select this if you want to use DWG Direct to process 
AutoCAD files.

• Use AutoCAD: Select this to use AutoCAD to process AutoCAD files. You 
must have AutoCAD installed and properly configured to use AutoCAD.
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Adding Files from a Polled Directory
You can add files to the Job Editor from a specified polled directory, while using 
other PlotWorks functions. When a file is found in the polled directory, it is copied 
to a destination directory and added to the job ticket. The files are then deleted 
from the polled directory. 

This function is useful when using Océ Power Logic driven scanners.

To use this function, first create the destination and polling directories.

Creating the Directories:
1. Right click on the Windows Start button.
2. Click on Explore. Windows Explorer opens.

3. Click on the Drive or Directory you wish to create the Polling directory in. 
For example, click on Local Disk (C:) to create the directory in the C drive.

4. Click on the File menu.

5. Select New

6. Click on Folder. A folder is added towards the bottom left of your screen 
named New Folder.

Fig 4.46 
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7. Right click on the New Folder.

8. Select Rename from the right click menu. The text New Folder is 
highlighted.

9. Type in a name for the directory to poll.

10. Repeat steps 3 to 9 to create the destination folder.

11. Close Windows Explorer

If the Polling directory is located on the same computer as PlotWorks, the 
directory needs to be “shared”.

To Share a Directory:

1. Right click on the directory you want to share.
2. Select Sharing from the right click menu.

3. Select the Shared As radio button.

4. Click on the OK button.

The directory is now shared.

Using the Poll Directory Function:
1. Click on the Job Editor File menu.

Fig 4.47 
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2. Select Add Files.

3. Click on Poll Directory. The Polling Directory Options dialog box opens.
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4. The Directory to Poll text box is empty the first time this function is used, 
otherwise the text box displays the last directory polled. Click on the first 
Browse button to select a new Polling Directory. The Browse for Folder 
dialog box opens. Select the directory to poll. If you have not already created 
this directory, follow the steps outlined on the previous page and create a 
Polling and a Destination Directory before continuing. Click on the OK 
button. The Browse for Folder dialog box disappears and your Polling 
Directory is entered in the first text box.

5. The Destination Directory text box is empty the first time this function is 
used, otherwise the text box lists the last directory used. To select a new 
Destination Directory, click on the second Browse button. The Browse for 
Folder dialog box opens. Select the desired Destination Directory. Click on 
the OK button. The Browse for Folder dialog box disappears and your 
Destination Directory is entered in the second text box.

6. The File Filter text box is used to specify what file type to poll for. To select 
all files enter *.*. To specify only certain file types enter *. and then the file 
extension. For example to only poll for TIFF files enter *.tif.
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7. Select automatic file naming options from the File Name Generation and File 
Naming Options group boxes. Options include:

• Prefix: Enter text to make up the first part of the file name.

• Suffix: Enter text to use as the last part of the file name, before the file 
extension.

• Don’t generate File name: Select this radio button if you do not want a 
file name automatically assigned.

• Prefix only: Select this radio button if you only want a prefix assigned 
to file names.

• Prefix with auto-increment: Select this radio button if want a prefix and 
then an incrementing number assigned for the file names.

• Prefix and suffix with auto-increment: Select this radio button if want 
a prefix, then an incrementing number, and then a suffix assigned for file 
names.
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• Start number: Enter a starting number for this polling session. This 
number becomes part of the file name.

• End number: Enter an ending number for this polling session. This is 
the last number used for the file name before the automatic numbering 
system rolls back to the starting number.

• Next filename: Text following this label, displays what the next file will 
be named.

• Use original filename, adding a unique number if needed: Select this 
radio button to use the original filename.

• Prompt for manual entry of filename after each file: Select this radio 
button if you prefer to individually enter a file name for each file.

• Auto-generate a filename (don’t prompt after each file): Select this 
radio button to automatically generate file names, using options selected 
in the File Name Generation group box.

8. Once you have selected your Directory Polling options and are ready to start 
polling, click on the OK button. A Polling Directory dialog box opens. If 
there are already files in the Polling Directory, they are added to the Job 
Editor.The progress bar on the dialog box illustrates the file transfer progress. 
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Every time a file enters the Polling Directory it is moved to the Destination 
Directory and added to the job ticket. The files are then deleted from the Polling 
Directory. 

You can perform other tasks on the Job Editor while polling. However only one 
directory can be polled at the same time.
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Duplicating file names while polling a directory

While polling, if a file has the same name as an existing file in the Destination 
directory or the Job Editor, a dialog box opens asking how you would like to 
handle the new file.

Fig 4.50 
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Click on the appropriate button to select what to do with the new file. Choices are:

• Retry: Select this button to retry adding the file.
• Overwrite: Selecting this button will replace the old file with the new one.
• Specify Name: Select this button to manually enter a name for the new file.
• Auto-Rename: Select this button to automatically rename the new file.
• Ignore: Selecting this button ignores the new file. The file is not added to the 

job ticket or to the destination directory.
• Abort: Selecting this button stops the polling process.

Select the check box labeled Apply to all items, if you want all files with 
duplicate file names handled in the same way during the polling session.

Stopping Polling

To stop polling click on the Stop button on the Polling Directory dialog box. 
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Adding Files from a Polled FTP Directory
You can add files to the Job Editor directly from a polled FTP directory while 
using other PlotWorks functions.  When a file is found in the FTP directory it is 
copied to a destination directory and added to the job ticket.  The files are then 
deleted from the FTP directory. 

This function is useful when using AccXES Controller driven scanners.

To use this FTP polling function you must first set up your FTP directory, 
including the polling directory, user names and passwords, and create a 
destination directory. 

Using the Poll Directory Function:
1. Click on the Job Editor File menu.
2. Select Add Files.

Fig 4.51 
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3. Click on FTP Directory. The FTP Polling dialog box opens. This dialog box 
may contain information last entered. Edit this information as necessary. 

The following information is entered in the FTP Polling dialog box:

• User: Enter the assigned user name.

• FTP Server: Enter the FTP address in this text box.

• Port: Enter your FTP port number in this text box, usually 21.
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• Password: Enter the password assigned to the user.

• Remote Directory to Poll: Enter the complete path on the FTP server 
for the directory to poll. For example: /public/mydirectory

• File Filter: Enter the file type to poll for. To select all files enter *.*. To 
specify only certain file types enter *. and then the file extension. For 
example to only poll for TIFF files enter *.tif.

• Remember Password: Select this check box if you entered a password 
and want the application to remember your username and password so 
that you do not have to enter it each time.

Fig 4.52 
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• Destination Directory: Enter the path for the Destination Directory or 
click on the Browse button and select a path.

The File Name Generation and the File Naming Options group boxes contain 
automatic file naming options. These include:
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• Prefix: Enter text for the first part of the file name.

• Start number: Enter a starting number for this polling session. This 
number becomes part of the file name.

• Suffix: Enter text for the last part of the file name, right before the file 
extension.

• End number: Enter an ending number for this polling session. This is 
the last number used for the file name before the automatic numbering 
system rolls back to the starting number.

• Don’t generate Filename: Select this radio button if you do not want a 
file name automatically assigned. Do not select this option when Auto-
generate a filename (don’t prompt after each file) is selected, as this 
will create blank file names.

• Prefix only: Select this radio button if you only want a prefix assigned 
for file names.

• Prefix with auto-increment: Select this radio button if want a prefix and 
then an incrementing number assigned for file names.

• Prefix and suffix with auto-increment: Select this radio button if want 
a prefix, then an incrementing number, and then a suffix assigned for file 
names.

• Next filename: Text following this label, displays what the next file will 
be named.

• Use original filename, adding a unique number if needed: Select this 
radio button to use the original file name. A hyphen and a unique number 
is appended to the original file name when necessary.

• Prompt for manual entry of filename after each file: Select this radio 
button if you prefer to enter a file name for each file.

• Auto-generate a filename (don’t prompt after each file): Select this 
radio button to automatically generate file names, using options selected 
in the File Name Generation group box.

4. Once you are ready to start polling, click on the Start Polling button. Polling 
options cannot be edited during Polling. If there are already files in the 
Polling Directory, they are added to the Job Editor. 

When a file enters the FTP Polling Directory it is moved to the Destination 
Directory and added to the job ticket. The file is then deleted from the Polling 
Directory.
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If you are running a XEROX WIDE FORMAT device using the AccXES 
controller, and a TIFF and a JPG version of the file is added to the Destination 
Directory every time a file is downloaded, disable the scanner’s preview option.

Appendix B lists all the errors that FTP Polling may generate.

You can perform other tasks on the Job Editor while polling. However only one 
directory can be polled at the same time.

Stopping Polling

To stop polling click on the Stop Polling button on the FTP Polling Directory 
dialog box. 
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Scanning from Twain Devices
You can scan images directly into the job grid from TWAIN devices. TWAIN is 
a standard method for communicating between software and image acquisition 
devices. The Kyocera Mita 4850 and the Xerox Synergix are Twain scanners. 
Most small format scanners are TWAIN devices. Please see Appendix F for more 
details.

PlotWorks supports monochrome, 8-bit grayscale, and 24 bit color images using 
TWAIN devices. 

.Before you can add images to a job from a TWAIN scanner, you must ensure that 
the scanner is detected by your computer.

Confirming your computer detects the scanner:
The instructions below assume you are running Windows XP. If not please consult 
your Windows or scanner documentation on how to confirm your scanner is 
detected. The steps involved will not vary greatly.

1. Click on the My Computer icon on your Windows desk top. The My 
Computer window opens.

2. Click on the Control Panel icon. The Control Panel window opens.

3. Click on Scanners and Cameras. The Scanners and Cameras property 
dialog box opens. If your scanner is properly installed and detected, it is listed 
in this dialog box. If not, follow the instructions below to add the scanner to 
your computer.

Adding a TWAIN imaging device to your computer:

1. Click on My Computer, then Control Panel, then Scanners and Cameras. 
This opens the Scanners and Cameras property dialog box.

2. Click on the Add button. The Scanner and Camera Installation Wizard 
dialog box opens. Follow the prompts this wizard provides until your scanner 
is properly installed.

There are many ways to add a scanner to your computer. If the instructions here 
did not work for you, follow the documentation provided by your scanner 
manufacturer. 

Twain Scanning Options
The Twain Scanning Options dialog box is used to select file naming options for 
scanned images, and set other TWAIN scanning options. 
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Setting Twain Scanning Options

Fig 4.53 
Setup 
menu

1. Click on the Setup menu.
2. Click on Twain Options. The Twain Scanning Options dialog box appears.

3. Enter values for options provided in this dialog box. The following options 
are available:

Scanning Options:

• Show on scanner startup: Select this check box if you want the Twain 
Scanning Options dialog box to appear every time you select Acquire 
from the TWAIN sub menu. 

• Confirm file replacement: Select this check box if you want a dialog 
box to warn you every time you are about to overwrite a file.

• Scan directory: This drop down list is used to select a location to save 
scanned images to. This same option is available under Default file 
paths in the Setup Preferences menu. Changes made in either location is 
reflected in both places. For more information refer to Page 4-66 of this 
chapter.

• Specified Path: This field and its associated Browse button is only 
enabled when “to the specified path” is selected in the Scan directory 
drop down list. The Browse button is used to specify the desired path.
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File name Generation: Options selected here are used to create 
automatically assigned file names for scanned images.

• Prefix: Text entered in this text box is used as the file name prefix. 

• Suffix: Text entered in this text box is used as the file name suffix. 

• Don’t generate file name: Select this radio button if you do not want a 
file name automatically assigned.

• Prefix only: Select this radio button if you only want a prefix assigned 
for file names.

• Prefix with auto-increment: Select this radio button if want a prefix and 
then an incrementing number assigned for the file names.
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• Prefix and suffix with auto-increment: Select this radio button if want 
a prefix, then an incrementing number, and then a suffix assigned for file 
names.

• Start number: Enter a number in this text box. This number is used as 
the first number for the automatic naming sequence. For example if the 
number 0 is entered here, the first scan will be named "Stadium0". 

• End number: Enter the largest value you would like for the suffix 
number in this text box. When the automatic name generator reaches this 
number, it will roll back to 0. If you wish to roll back to a different 
number you will need to manually increment it. 

• The Next filename: Text following this label displays what the next 
filename will be.

File Naming Options: 

• Prompt for manual entry of filename after each file: Select this radio 
button if you wish the application to prompt you for a filename for each 
scan.

• Auto-generate filename (don’t prompt after each file): Select this 
radio button if you wish the application to automatically generate file 
names using information entered in the Auto naming options group box.

File format options

• Save as: Select TIFF or PDF from the drop down list.

• Extension: Enter tif or pdf. The scanned image is assigned the file 
extension specified in this text box. This extension is automatically 
appended to all filenames even when not using the automatic naming 
feature.

4. When you have completed setting your options, click on the OK button.

Adding images to the Job Editor from a TWAIN scanner: 
This involves two tasks. First you select the TWAIN scanner you wish to add 
images from and then you add the images.

Selecting the TWAIN scanner:

1. Click on the File menu.
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2. From the File menu, select TWAIN. Under the TWAIN sub menu are two 
options:

• Acquire: Gets images from the currently selected twain device.

• Select Source: Shows a list of twain drivers on the machine and lets the 
user select one.

3. Click on Select Source. The Select Source dialog box opens listing all the 
TWAIN devices detected.
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4. Select the scanner that you wish to acquire images from. If the scanner you 
want is not listed here you need to add the scanner to your computer. Refer to 
the instructions above on Adding a TWAIN imaging device to your 
computer.

5. Click on the Select button. The scanner is selected and the Select Source 
dialog closes.

Acquiring images from a TWAIN scanner:

Before you can acquire images from the TWAIN scanner you need to select the 
TWAIN source. Refer to the previous page for instructions on how to select your 
TWAIN source.

1. Click on the File menu
2. Select TWAIN.

3. Click on Acquire. Either the scanner manufacturers TWAIN scanner driver 
dialog box will open ready for scanning, or the TWAIN Scanning Options 
dialog box will. 

The TWAIN Scanning Options dialog box will only open if the Show on 
scanner startup check box is selected. Confirm the options selected are still 
desired. For more information on these options see “Twain Scanning 
Options” on page 4-88.

Click on the OK button. The scanner manufacturers TWAIN scanner driver 
dialog box will now open for scanning. 
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Output to File
The Output to File option is used to save any file as a TIFF or PDF file. You can 
create multi-page TIFF or PDF files. All print parameters assigned in the job grid 
are included in the saved file including watermarks, overlays and labels.

To save a file as a PDF it is necessary to have purchased and installed the PDF 
Option

Using Output to File
1. Open the Job Editor if it is not already open.
2. Add the files you wish to convert to the job grid.

3. Select printing and size properties for each file.

4. Click on the File menu

Fig 4.57 
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5. Select Output to File from the File menu. This opens the Output to File 
dialog box.

6. Enter values for the following options:
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• Destination Path: Click on the Browse button to select a folder to save 
the converted file/s in. Or enter the folder name and path in the text box.

• Selected Files Only: This option is only available if a file is selected 
(highlighted) in the job grid. Select this check box if you only want to 
convert the files currently selected in the job grid.

• Use Original Filenames: Select this check box to assign the same file 
name as the original file with either a TIFF or PDF extension. When this 
option is not selected, you are prompted to enter a name for each file.

• Create PLP Job File: Select this check box to convert the files into TIFF 
or PDF files and also create a print job using the converted files and the 
print parameters assigned in the job grid. When this check box is 
selected, the text box becomes available so that you can enter a name for 
the PLP Job file. The default name is Output.plp

• Create Multipage Document: Select this check box to save all the files 
as one multipage document. Each individual page of the multipage 
document retains its original size or if a size is specified in the job grid, 
each page is scaled to that size.

When Create Multipage Document is selected, the Multi Page Selected 
dialog box appears. This dialog box informs you that if a multipage 
document contains multiple final sizes, PlotWorks may not be able to 
print the files correctly.

Fig 4.58 
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Clicking on the Cancel button will return you to the Output to File dialog 
box and Create Multipage Document will no longer be selected. 
Clicking on the OK button will return you to the Output to File dialog 
box. Create Multipage Document will still be selected and the text box 
next to it is now available for you to enter a name for the multipage file. 

• Format: Select either TIFF or PDF depending on the file format you 
wish to save the file as. Depending on whether TIF or PDF is selected, 
different Compression options are available. 
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To save a file as a PDF it is necessary to have purchased and installed the PDF 
Option

• Compression: From this drop down list select the desired compression 
type. 

TIFF compression choices:

• DEFAULT: When this option is selected, the best compression 
based on the color model, bit depth, etc. is applied

• NONE
• PACKBITS
• GROUP 3
• GROUP 4: This is the default value.
• RLE

PDF compression choices:

• DEFAULT: When this option is selected, the best compression 
based on the color model, bit depth, etc. is applied

• NONE
• LOW
• MEDIUM: This is the default value.
• HIGH

• Resolution: From this drop down list select the desired image resolution 
in DPI. Choices available are:

• 200: This is the default value.
• 300
• 400
• 600

• Compress files into ZIP file: Select this check box to compress the 
converted file/files into a compressed ZIP file so that the files are easier 
to send electronically and will occupy less drive space. When this check 
box is selected, the text box becomes available so that you can enter a 
unique name for the ZIP file. The default name is Output.zip

• Disable ARU log: Select this check box if you do not want to generate 
an ARU log for Output to File functionality. Otherwise an ARU log is 
created (if ARU file support is enabled). Information collected by the 
Output to File function is specified in the rptPublisher.def file.



PlotWorks User Guide • The Job Editor • 4-97

7. Click on the OK button. If you did not select the Use Original Filenames 
check box, the Please enter a file name dialog box appears. 

Ensure you select a different name for each file or else you will overwrite a 
previously saved file.

Fig 4.59 
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Enter a unique filename in the text box and click on the OK button. If the 
Create multipage document check box is not selected and there is more than 
one file to convert, the dialog box will continue to reappear until all the files 
are named.

The Outputting dialog box will appear to display the file creation process. 

Fig 4.60 
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To cancel the process, click on the Cancel button. 

Fig 4.61 
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The Process Cancelled dialog box will appear. You then have three options:

• Yes: Click on the Yes button to keep the created files.

• No: Click on the No button to delete the created files.
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• Resume: Click on the Resume button to resume the Output to File 
process.

If a problem occurs during this process an Error during processing dialog box 
appears. Click on the OK button or click on the View Log button to determine 
what the problem was. 

Once all the files have been converted and saved successfully, the dialog box 
below will appear.

Fig 4.62 
Output to 
File dia-
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8. Click on the OK button.
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Revision Highlighting
The Revision Highlighting function is designed to compare two image files and 
illustrate the differences between the two files. This is useful when you have two 
copies of the same file and you want to know if the files are identical or not. 

To use the Revision Highlighting option it is necessary to have purchased and 
installed the Revision Highlighting Option Code.

Revision Highlighting only works when comparing HPGL and HPGL 2 files that 
are the same size, and are generated using the same software and driver. Revision 
Highlighting cannot be used with scanned in image files.

PlotWorks creates a file that illustrates the differences, if any, between the two 
files. This file is referred to as the Compared file. The Compared file is a TIFF 
file that can be viewed, saved or printed.

Because the changes indicated by the Compared file are displayed in color, it is 
best to confirm that the viewer selected to view TIFF files is a color viewer. 
Instructions on selecting viewers for various file types are provided on Page 4-10. 
The PlotWorks Image Viewer is not a color viewer. Therefore it will not show the 
differences between the two files. 

Using Revision Highlighting

Only users logged onto the PlotWorks computer with Local Administrative rights 
can use the Revision Highlighting feature.

1. Ensure that the two files you wish to compare are listed in the Job Editor grid. 
If not, add the two files.

2. Click on the Revision Highlighting button or select Revision Highlighting 
from the Edit menu. The Revision Highlighting dialog opens displaying the 
Compare Configuration tabbed dialog box.
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3. Click on the Old Revision drop down list. The drop down list displays listing 
all the files contained in the Job Editor grid.

4. Select the file you think is the older of the two files you want to compare.

5. Click on the New Revision drop down list. The drop down list displays all the 
files listed in the Job Editor grid.

6. Select the file you think is newer of the two files you want to compare.

You can also select the two files you wish to compare in the Job Editor grid. Then 
click on the Revision Highlighting button. In this case the selected files will 
populate the Old and New Revision drop down lists when the Revision 
Highlighting dialog box opens. The first file listed in the grid populates the Old 
Revision drop down list. To reverse the two listings click on the Reverse Order 
button.

7. Click on the Compare button. The generated Compared file is listed in the 
Job Editor grid and the selected TIFF Image Viewer may open displaying a 
preview of the Compared file.
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Revision Highlighting Options
Before comparing the two files it is best to select if and where you want to save 
the Compared file, what files you will want to print, and whether to preview the 
Compared file or not. If you do not select these options before comparing the files 
the default settings are applied. 

The Compare Configurations Tabbed Dialog Box

The following options are available from this dialog box:

• File Settings options

• Old Revision: Select the older of the two files you wish to compare from 
this drop down list.

• New Revision: Select the newer of the two files you wish to compare 
from this drop down list.

• Reverse Order: Select this button if you wish to switch the files selected 
for Old and New Revision.

• Compare File: This text box is used to enter a name for the Compared 
file. A default name is automatically provided. This is always Comp_ 
followed by the filename selected in the New Revision drop down list.
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• Batch compare: Select this check box to compare multiple drawings. In 
this case, the first half of the images listed in the Job Editor grid are 
compared to the second half of the images. The first half of the files listed 
are considered the old files and the second half are considered the new 
files. Each pair of files is referred to as a set.

For example, if there are 6 files in the job there are 3 sets, File 1 is 
considered old and is compared to File 4, File 2 is compared to File 5, 
and File 3 is compared to File 6. 

It is necessary to have an even number of images listed in the Job Editor to use the 
Batch compare option. 

When Batch compare is selected the following options are unavailable: 
"Old Revision", "New Revision", and "Reverse order". Nor are you able 
to view files.

• Subtractions Setup: These options refer to items that are contained in the file 
specified as the Old Revision that are not included in the file specified as New 
Revision. 

• Grey: Select this radio button to display items contained in the Old 
Revision, not included in the New Revision, in grey. This is the default.

• Exclude: Select this radio button if you do not want to display items 
contained in the Old Revision, that are not included in the New Revision.

• Specify: Select this radio button to select a color to display items 
contained in the Old Revision, not in the New Revision. Use the provided 
drop down list to select the color.

• Unchanged Setup: These options refer to items that are unchanged in the Old 
Revision and the New Revision files.

• Black: Select this radio button to display unchanged items in black. This 
is the default.

• Exclude: Select this radio button if you do not want to display unchanged 
items.

• Specify: Select this radio button to select a color to display unchanged 
items. Then use the provided drop down list to select the color.

• Additions Setup: These options refer to items that are contained in the file 
specified as the New Revision that are not included in the file specified as Old 
Revision.

• Highlight Color: Select this radio button to display items contained in 
the New Revision, not included in the Old Revision, in your printers 
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highlight color. On the MAX 200 printer this is red. This is the default 
setting.

• Exclude: Select this radio button if you do not want to display items 
contained in the New Revision, that are not included in the Old Revision.

• Specify: Select this radio button to select a color to display items 
contained in the New Revision, that are not in the Old Revision. Use the 
provided drop down list to select the color.

• Graphic Sample: This part of the Compare Configuration tabbed dialog box 
contains graphics to intuitively illustrate how Revision Highlighting works 
and how the Compared file will display. As options selected under 
Subtractions and Additions Setup are changed, the image called Comparison 
changes to illustrate your choices.

The File Configuration Tabbed Dialog Box
Select this dialog box by clicking on the File Configuration tab of the Revision 
Highlighting dialog box.

The following options are available from this dialog box:

• Save Compared File: Options here are used to select if and where to save the 
Compared file. 

• Don’t save: Select this option if you do not want the Compared file 
saved. The file is created in the preproc folder specified under the Setup 
pulldown menu in the Processing Options section of the Job Editor.

• Save with old rev: Select this option if you want the Compared file 
saved in the same folder as the file selected as the Old Revision (see Page 
4-101 of this chapter for more information).

• Save with new rev: Select this option if you want the Compared file 
saved in the same folder as the file selected as the New Revision (see 
Page 4-101 of this chapter for more information).
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Fig 4.65 
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• Specify location: Select this option if you want to specify which folder 
to save the Compared file to. If selected enter the folder name and path 
in the text box below. You can either type in this information or you can 
use the provided Browse button to select the folder (The browse button 
is indicated by three tiny dots. To do so:

• Ensure the folder exists. If not use Windows Explorer and create the 
folder.

• Click on the Browse button. The Browse for Folder dialog box 
opens.
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Fig 4.66 
File Con-
figuration 
tabbed di-

alog box

• Navigate to the folder you wish to save the file in.
• Click on the OK button. The Browse for Folder dialog box 

disappears and the selected folder and its path are listed in the 
Specify location dialog box.

• Print Settings: These options are used to select which files to print once the 
files have been compared and Output is selected from the Job Editor

• Compare file only: Select this option if you wish to only print the 
Compared file. When this option is selected, and the files are compared 
in the Job Grid, an X will appear under Quantity for the files selected as 
Old and New Revisions and 1 is entered for the Compared file.

• Compare file and old rev: Select this option if you wish to print the 
Compared file and the file indicated as the Old Revision. When this 
option is selected, and the files are compared in the Job Grid, an X will 
appear under Quantity for the file selected as the New Revisions and 1 is 
entered for the Compared file and for the file selected as Old Revision.

• Compare file and new rev: Select this option if you wish to print the 
Compared file and the file indicated as the New Revision. When this 
option is selected, and the files are eventually compared, in the Job Grid, 
an X will appear under Quantity for the file selected as the Old Revision 
and 1 is entered for the Compared file and for the file selected as New 
Revision.

• Compare file and both revs: Select this option if you wish to print the 
Compared file and the both the files being compared once the 
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Comparison is made. In the Job Grid, 1 will appear under Quantity for all 
three files.

• Viewing: Select the Auto preview compared file check box if you always 
want to always view the Compared file. 

The Revision Highlighting Dialog Box Buttons
The following buttons are found on the Revision Highlighting dialog box:

• Compare: Select this button to compare the files listed in the Old and New 
Revision fields. The Compared file is added to the Job Grid. If the Auto 
preview compared file check box is selected, the Compared file displays in 
the Viewer. 

When Batch Comparing

If the Batch compare option is selected, the Batch Compare dialog box 
displays providing the following information:

• The set number currently being compared and the total number of sets in 
the batch.

• The old revision filename

• The new revision filename

• The compared file filename.

Fig 4.67 
The Batch 
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dialog box

Clicking on the Cancel button on the Batch Compare dialog box stops batch 
comparing. If a set had already completed being compared, its comparison 
file is added to the job grid.
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Fig 4.68 
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When the batch comparison is completed the Batch Compare Finished dialog 
box appears displays whether each set was compared successfully. If a 
problem is encountered, it is reported here. 

• Cancel: Closes the Revision Highlighting dialog box without saving the 
options selected.

• Close: Closes the Revision Highlighting dialog box saving the options 
selected.

• Help: Opens the Job Editor chapter (Chapter 4)of the User Guide. 

Possible error messages generated by Revision Highlighting
• Could not create output directory. Operation Aborted. 

If the specified output directory does not exist the user is prompted to 
create it. 

• Couldn’t launch the Publisher because it could not be found.

The Publisher is not installed or not installed correctly

• Couldn’t launch the Publisher because it is not registered properly.

The Publisher is not installed or not installed correctly

• The file C:\Compare\Comp_v2.tif already exists. Would you like to 
overwrite? 

• Click OK if you wish to overwrite the compared file. 
• Click No if you do not wish to overwrite the compared file. if No is 

selected the Operations canceled dialog box appears:

• Operation canceled. 
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The last operation being performed is canceled.

• Please select an old and a new revision.

This occurs if an old and/or new revision file is not selected in the drop 
lists. 

• The PlotWorks image viewer does not support color tiff images. 

This error occurs if auto view is checked and the Plotworks Image 
Viewer is set as the default viewer for tiff files. 

• There is no image data in either of the files. The images can not be 
re-aligned.

This message appears when both images are blank and Re-align to first 
pixel is selected. 

• There is no image data in the file [Filename]. The images cannot be 
re-aligned.

This message appears when one of the images is blank and Re-align to 
first pixel is selected. 

• Revision images are incompatible

This occurs when the two original images are different sizes. 

• The specified output directory C:\Compare doesn’t not exist. Would 
you like to create it?

If the specified output directory does not exist the user is prompted to 
create it. 

• Unable to batch compare the job when it contains an uneven amount 
of images. 

This occurs when there are an uneven number of images listed in the Job 
Editor and Batch compare is selected. To resolve this problem, click on 
the OK button. The Batch compare option is automatically deselected. 
Then edit the Job Editor grid so that an even number of files are listed 
and try again.
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Process Image Files
All images in a job ticket must be processed before they are printed. Processing 
converts the images to PlotWorks’ proprietary file format, Performance Graphics 
Standard (PGS). During processing, the Error Free Printing function checks for 
inconsistencies between actual image data and specified printing parameters 
(unless set to Auto Detected or User Specified) and either corrects them 
automatically or requests operator intervention.

When you view an image, the Job Editor automatically processes it, if needed, 
before opening the PlotWorks Image Viewer (if an external viewer is being used, 
no processing is done).

You can process individual images, groups of images, or an entire job by selecting 
the Process button

The Process Job dialog box
When the Process button is selected the Process Job dialog box opens. 

Fig 4.69 T
he Process 
Job dialog 

box

The following options are available here:

• Process selected files: Select this check box to process only the files already 
selected in the job grid. This option is only available if a file is selected in the 
job grid. When this option is not available all files listed in the job grid are 
processed when the OK button is clicked. If this check box is not available 
and you wish to only process selected files, click the Cancel button, select the 
files to process and click on the Process button again.

• Continue processing: Select this option to automatically process required 
files as necessary.

• Show all notices: Select this option to display all processing notices. We 
recommend only using this option for trouble shooting purposes.

• OK: Click this button to start processing. The Job Editor processes the files 
and displays any warning or error messages that occur. If an error occurs, a 
warning dialog box may appear and you will need to select one of the 
following options:
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• Print Anyway: This option continues processing a job that has been 
partially processed and ignores warnings that have already been okayed.

• Skip Image: This option tells PlotWorks to skip the image that contains 
the error or warning and continue with the next image in the job.

• Halt Processing: This option cancels the processing of all images in the 
job and returns you to the Job Editor screen.

• Ignore all: This option processes the entire job and ignores 
(automatically accepts) all Error Free Printing notices.

• Cancel: Select this option to close the Process dialog box without processing 
any files.
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Viewing Image Files
You can view any image file listed in the job grid. Before you attempt to do so it 
is necessary to ensure you have selected what image viewer to use. 

You can choose to use the PlotWorks Image Viewer for all image types by 
selecting Always use PlotWorks Viewer from the View menu. (See page  4-10.) 
Or you can choose a different image viewing software product for each type of 
image file by using the options provided in the Configure Viewers dialog box. See 
page  4-10.

The PlotWorks Image Viewer 
The PlotWorks Image Viewer lets you view the files in your print jobs and make 
adjustments to the prints. You can access the Image Viewer from within the Client 
or Job Editor. The PlotWorks Image Viewer lets you:

• Zoom in and out.
• Show or hide individual pens (display only).
• Adjust the origin of the image.
• Adjust the output size.

More information on using the PlotWorks Image Viewer is provided in Chapter 
4B of this User Guide.

The Windows XP Viewer
The Windows XP Viewer can also be used to view images from the Job Editor. 
When using this viewer to view TIFF images, do not rotate or change the image. 
This is because the XP Viewer will then automatically save the image in a format 
that PlotWorks does not support. To resolve this problem it will be necessary to 
open the image in a third party application like Adobe PhotoShop and then save 
the file, using no compression.

Viewing an image
To view an image listed in the job grid do one of the following:

• Double click on the image number in the job grid
• Select an image and then click on the View button
• Select an image and then click on the View menu and select View image.
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Configure an Output Destination
If you are sending jobs over a local network or modem, or to a Queue directory 
from the Print Server, you must specify your destination and transmission mode. 

If you are sending your job to a disk, you do not need to configure a destination.

Configuring Multiple Destinations
PlotWorks supports multiple destinations. This makes it much easier to manage 
multiple Network Polling directories and multiple Job Queues. Configure the 
different destinations and then select it from the Send to: drop-down list when you 
are ready to output the job.

1. Open the Setup menu and select Configure Destinations. The Configure 
Destinations dialog box displays.

Fig 4.70 
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2. Click Add to display the Add Destination dialog box.

Fig 4.71 
Add Des-
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dialog box
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3. Enter a descriptive name in the Destination name field. This name appears 
as a selection in the Output Job dialog box.

4. Select one of the Destination Type radio buttons depending on what type of 
output destination you are setting up. Information on each Destination Type 
follows.

5. In the Destination Path field, specify a destination directory using the 
Browse button, or by typing in the UNC path (\\Computer\Shared 
Folder\Folder).

6. From the Options group box, select options by clicking in the appropriate 
check box. Options available are:

• Send Additional Information from TEMPLATE.INF file: Select this 
option if you wish to send information contained in the Template. INF 
file with the job ticket. The Template.INF is required if selecting this 
option

• Prompt for user information on submission: This check box is 
selected by default. User Information is automatically included in the 
.INF file. Selecting this option generates the User Information dialog box 
when the job is submitted for printing. This allows you to make final 
changes to the user information if required.

• Use dial-up networking to connect to destination: Select this option if 
you wish to use Dial-up Networking and RAS/Dial-up Networking is 
installed and configured correctly. This activates the fields in the Dial-up 
Configuration group box. Select the destination phonebook entry, and 
enter your account and password in the appropriate fields. Appendix G 
contains more information on this subject.

If the client is running on Windows 95 or 98,the client must notify the service 
bureau or the PlotWorks hub administrator if the network logon user name 
changes. This name must be changed at the receiving server as well before jobs 
can be sent.

If RAS is not installed, this field is disabled. RAS (Remote Access Service) is the 
Windows NT version of Dial-up Networking (Windows 95). RAS/Dial-up 
Networking must be installed (from your Windows NT or Windows 95 CD) and 
configured in the Windows operating systems for both the client (for sending) and 
server, or hub (for receiving). Refer to Appendix G “Configuring RAS to Output 
PlotWorks Job Files” or check with your Network Administrator for instructions.
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• Compress all files into single file prior to submission: Selecting this 
option compresses all files in the job grid and the PLP file into a single 
PWC file. This speeds up the file transfer process when submitting from 
the Job Client to a Network Polling Mode 2 or 3 directory. This option is 
only available when Network Poling is selected for destination type. 

PWC files are compressed files that contain image files as well as the PLP file that 
make up a job. These files are created when Compress all files into single file is 
selected in the Job Editor or Client. If the PlotWorks DOS version is used, the files 
are compressed into a PWJ file. 

7. Click OK.

Destination Types
The Job Editor takes different actions when outputting depending on the 
destination type selected. The following destination types are available:

• Directory: This option is used mainly for archiving files or sending them via 
RAS to a specified directory location. Subdirectories are not created. 
Therefore, if two files with the same name are submitted, one will overwrite 
the other. This option is not used for Network Polling directories as it does 
not support PGS files. Selecting this option disables the 'Compress all files 
into single file prior to submission' check box 

• Network Polling: This option sends your job to a target directory used by the 
Network Polling program or the DOS-based NetQuery program. When you 
send jobs to this destination, the Job Editor automatically creates a numbered 
subdirectory for your files within the polling directory. This selection is 
recommended for service bureau environments because it prevents remote 
users from directly accessing the Queue. This option should be used when 
submitting PGS files.

• Job Queue: This option sends your job directly to a Job Queue. When you 
send jobs to this destination, the Job Editor automatically creates a job 
directory for your files within the Queue directory. This selection is 
recommended for in-house industrial/architectural/engineering 
environments.

• FTP: This option lets you send your job to a polled directory on an FTP 
server. FTP uses the connection-oriented services of TCP to transfer text and/
or binary files between a local host running TCP/IP and a host configured 
with an FTP server program. See “Installing FTP” on page G-531 for 
information on installing FTP service on the host server and client 
workstation, if necessary.
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See also: “Output Jobs” on page 4-70.

To set up a local area network destination:

1. Open the Setup menu and select Configure Destinations. The Configure 
Destinations dialog box displays.

2. Click Add to display the Add Destination dialog box (see Fig. 4.38).

3. Enter a descriptive name in the Destination name field. This name appears 
as a selection in the Output Job dialog box.

4. In the Destination path field, either enter the path and directory to which the 
files will be sent, or use the Browse button. Be sure the network destination 
is accessible from the PC you are configuring before choosing this path.

5. Select a Destination type (see Destination Types above for more 
information).

6. Select Send additional information from Template.INF file if needed 
(Template.INF is required if selecting this option).

7. The Prompt for User Information on submission check box is checked by 
default. User Information is automatically included in the .INF file. When this 
box is selected, the User Information dialog box is generated when the file is 
submitted for printing. This allows you to make any final changes to the User 
Information before submission.

8. Click OK.

To set up a local Queue directory destination:

1. Open the Setup menu and select Configure Destinations. The following 
dialog box displays.

2. Click Add to display the Add Destination dialog box (see Fig 4.38).

3. Enter a descriptive name in the Destination Name field.

4. In the Destination Path field, either enter the path and directory to the Job 
Queue where the files will be sent, or use the Browse button. Be sure the 
network destination is accessible from the PC you are configuring before 
choosing this path.

A queue must exist before choosing it as a Queue destination. See “Create a New 
Job Queue” on page 3-82.

5. Select Job Queue in the Destination Type field.

6. Select Send additional information from Template.INF file if needed 
(Template.INF is required if selecting this option).
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7. The Prompt for User Information on submission check box is checked by 
default. User Information is automatically included in the .INF file. When this 
box is selected, the User Information dialog box is generated when the file is 
submitted for printing. This allows you to make any final changes to the User 
Information before submission.

8. Click OK.

Setting Up an FTP Destination

File Transfer Protocol (FTP) allows you to transfer one or more files between the 
local client and remote host fast. It can handle larger files than e-mail and uses the 
Internet as its means of connection.

Use this destination type when the remote host requests that you transfer your files 
using FTP. See “Installing FTP” on page G-531 if you need help installing and 
configuring FTP on your workstation or setting up an FTP server. 

In order to send job tickets from a client site using FTP, the client (Job Editor or 
PlotWorks Client) must have:

• TCP/IP installed on the end user’s computer
• A user account on the FTP server

To set up the client site, you need to know:

• The account name and password of the end user (who will be sending files)
• The host computer’s IP address. Then, in order to use a computer name, the 

LMHOSTS file must be configured on the client computer (see “Create an 
LMHOSTS File” on page G-526).

• Windows 95/98 or Windows NT 4.0 Workstation — check to make sure that 
TCP/IP is configured on your computer (see “Verify Current Configuration” 
on page G-501 or page G-10). 

Configuring PlotWorks to output jobs using FTP:

1. Open the Setup menu and select Configure Destinations. The Configure 
Destinations dialog box displays.

2. Click Add to display the Add Destination dialog box (see Fig 4.38).

3. Enter a descriptive name in the Destination name field (optional). This name 
will appear as a selection in the Output Job dialog box.

4. Click on the FTP radio button to select it as the Destination type.

5. In the Destination path, first enter your User Account name. Then a colon 
(:), your Account Password, an @ sign, and finally the IP Address of the 
remote Print Server, i.e., username:password@IP Address.
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Example: If the destination is using LAN, WAN or Dial-Up Networking, this 
information is required: 
• FTP Username: PlotWorks

• FTP Password: smith 
• Host’s IP Address: 131.107.2.2 (or computer name, if an LMHOSTS file 

has been configured
therefore you would enter in the Destination path:  
PlotWorks:smith@131.107.2.2

Example: If the destination is using a proxy, the destination path will contain: 
• Remote-Username: PlotWorks
• Host-Site: Xerox

• Remote-Password: smith 
• Proxy Name or IP address (a name is usually used): printserver 
Therefore, you would enter in the Destination path:  
PlotWorks@Xerox:smith@printserver (see Fig 4.49). 

6. Select the box that says Use dial-up networking to connect to destination.

If RAS is not installed, this field is disabled. RAS/Dial-up Networking must be in-
stalled (from your Windows NT, 95, or 98 CD) and configured in the Windows op-
erating system for both the client (for sending) and the server, or hub (for 
receiving). Refer to Appendix G:“Configuring RAS to Output PlotWorks Job 
Files,” for more information.

7. Select the destination phonebook entry, and enter your account name and 
password in the appropriate fields.

8. Select Send additional information from Template.INF file if needed 
(Template.INF is required if selecting this option).

9. The Prompt for User Information on submission check box is checked by 
default. User Information is automatically included in the .INF file. When this 
box is selected, the User Information dialog box is generated when the file is 
submitted for printing. This allows you to make any final changes to the User 
Information before submission.

10. Click OK to save the configuration and close the dialog box.

When you are ready to send a job using FTP, click Output Job and select the FTP 
site as the destination (if it is not already selected). See “Output to FTP” on page 
4-72 for more information.



4-118 • PlotWorks User Guide 

Edit an existing Output Destination
1. Open the Setup menu and select Configure Destinations. The Configure 

Destinations dialog box displays.
2. Click on the destination you wish to edit. This makes the Edit button 

available.

Fig 4.72 
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3. Click Edit. This displays the Edit Destination dialog box.

Fig 4.73 T
he Edit 
Destin-
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4. This dialog box contains the same options as the Add Destinations dialog box. 
Simply make the edits you desire and then press on the OK button
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Delete an existing Output Destination
You may only delete a destination if you have more than one destination 
configured and listed in the Configure Destinations dialog box.

1. Open the Setup menu and select Configure Destinations. The Configure 
Destinations dialog box displays.

2. Click on the destination you wish to delete. This makes the Delete button 
available.

Fig 4.74 
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3. Click Remove. This displays a dialog box confirming that you wish to 
remove the destination.

4. Click Yes the destination is removed.
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Sending Print Jobs
Send a Special Instruction File
You can specify within the Job Editor that you would like to send a job 
information (.INF) file with your job. This option requires that the 
TEMPLATE.INF file reside in your PlotWorks program directory, or in the 
directory from which you last added a file (the current directory). PlotWorks 
searches the current directory first.

A TEMPLATE.INF file is a customizable form that lets you attach additional 
information and instructions to your print job. The TEMPLATE.INF file is 
particularly useful in a service bureau setting, where many customers with 
different requirements are submitting jobs.

To create a TEMPLATE.INF file:

1. Open Notepad (click the Windows Start button, select Programs, then select 
Accessories).

2. Enter the questions that you want the .INF file to ask. End each sentence with 
either a ? or ^.

? Makes an optional question in the TEMPLATE.INF dialog box (you can 
click Next or OK without filling in the field).

^Makes a mandatory question in the TEMPLATE.INF dialog box (the 
Next and OK buttons remain grayed out until an answer is entered in the 
field).

3. Save the file as TEMPLATE.INF in the directory in which the PlotWorks 
Client or hub version of PlotWorks is installed. The default path is usually 
C:\Program Files\PLP\PlotWorks. For the Client, the default path is 
C:\Program Files\PLP\PlotWorks Client.

Fig 4.75 
Sample 

Template 
.INF file
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To send a TEMPLATE.INF file:

1. Open the Setup menu and select Configure Destinations. The following 
dialog box displays.

Fig 4.76 
Configure 

Destin-
ation dia-

log box

2. Click Add to display the Add Destination dialog box (see Fig 4.38).

3. Select Send additional information from Template.INF.

4. Click OK.

5. When you select Output to send your print job to a disk, network or modem, 
the TEMPLATE.INF file displays as the Special Instruction dialog box, 
shown below:

Fig 4.77 
Special 

Instruction 
dialog box

The questions are listed on 
the top half of the window. 

Type your responses in the 
bottom half. 

6. Click Next to proceed through the questions, or Back to return to the previous 
question. If the TEMPLATE.INF file requires you to answer a particular 
question, you cannot select Next or OK until you have entered a response.

7. When you have answered the last question, click OK. The job information 
file will be created and submitted with the job.



4-122 • PlotWorks User Guide 

Job Information
If a job information file was submitted with a job, you can view this file from the 
PlotWorks Job Queue in the Job Information log. Jobs with Special Instructions 
attached display a blue and white “i” icon in the Job Queue.

To view the job information file:

• Double-click on the blue and white “i” icon, or: 

1. In the Job Queue, click the right mouse button on the job to display the Job 
menu. 

2. Select View. A second menu displays.

3.  Select Job Information.

4. When you are finished viewing the information file, click Exit under the file 
menu. 

See also: Send a Special Instruction File on page “Send a Special Instruction 
File” on page 4-67.

Shortcut: Select the job you want to view and click the Job Information button. 
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Output Jobs
The Output Job command lets you send your job ticket, image files, and 
information file (if any) to a Job Queue for processing and printing. You can send 
a job over a network, modem, or disk, or directly to the Job Queue.

Before you output a job, be sure that you have configured your output destination 
properly. (Refer to “Configure an Output Destination” on page 4-58.)

Fig 4.78 
Output 

Job dialog 
box

To output a job:

1. Click on the Output button.   
2. Make your desired selections in the Output Job dialog box (shown above). 

The following options are available:

• Send to: Select a destination for the job.

If files are sent using RAS/Dial-up Networking, the connection is made 
automatically by the Job Editor. If the modem is being used by another program, 
the connection will fail.

• # of sets: Enter the number of sets you wish to print.

• Selected files only: Select this box to print only the files.

• Reverse standard print order: Select this box to reverse the order in 
which the software prints your sheets. 



4-124 • PlotWorks User Guide 

• Folding Options: Click this to generate the Folding Options dialog box 
to configure folding margins, cross-folds, etc., before outputting your 
files. The folding functionality controlled through the Folding Options 
dialog box is exactly like that found in the Preferences/Finishing 
Options tab window. More information on these options are provided on  
4-68.

Fig 4.79 
Folding 

Options di-
alog box

• Continue processing: Select this option to tell PlotWorks not to display 
warning messages which have already been displayed for an image and 
okayed by the user.

• Show all notices: Select this option to tell PlotWorks to show all 
warnings, even if they have been okayed.

The Processing options are available only when you have chosen to send PGS 
files.

• Job priority: Enter a number between 1 and 10, with 10 being the 
highest priority. This value determines the order in which jobs are 
printed.

• Device #: Select the printer’s device number. This number is defined in 
the Printer Interface program, in the Printing Configuration dialog box 
under the Setup menu. If there is only one printer, or you do not care 
which printer is used, select Any.

• Place job on hold: Select this to send the job to the Queue with a Hold 
priority. The job will not print until you change its priority in the Queue.
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• Ignore warnings: Select this to print the job regardless of processing 
warnings. Warnings are ignored only by the Job Processor. If the Job 
Editor processes the files, all warnings will display, unless you choose 
“Continue Processing” and have already processed or viewed the file and 
okayed the warnings.

• Use set memory: (Xerox MAX 200 and 8180, Océ 9800) Set memory 
allows the job request to be sent to the set memory of a printer instead of 
sending each set over again. In some cases, this function speeds up the 
printing process. 

3. Click OK to send your job.

Output to FTP
FTP uses the connection-oriented services of TCP to transfer text and/or binary 
files between a local host running TCP/IP and a host configured with an FTP 
server program.

1. Make sure you have configured FTP as the destination. “Configure an Output 
Destination” on page 4-58.

When outputting jobs to FTP, be sure to select Send original image files only or 
Send PGS files only on the Processing Options sheet. This is due to the fact that 
the date/time stamp on files is not maintained when sending via an FTP 
connection.

2. In the Job Editor grid, select the file or files you wish to send. 

3. Click the Output button or select Output Job from the File menu. The 
Output Job dialog box appears.

4. Select the FTP destination and other desired options and click OK.
A connection is made between your computer and the remote server, using 
the FTP protocol and RAS/Dial-up Networking as needed, to connect to the 
remote machine. 

5. The Transfer Job progress box displays the progress after each file is 
transferred. The destination progress bar indicates when the job is done. Once 
your files have transferred, the connection disconnects.

The transfer of your files is taking place over a phone modem so it is only as fast 
as the modem speed. Therefore, the larger the file the longer it will take.



4-126 • PlotWorks User Guide 


	Chapter 4
	The Job Editor
	Creating a simple job ticket
	To start a new job ticket:
	To add images to a job ticket:

	The Job Editor Window
	The Toolbar
	The Menus
	The Job Grid

	Changing Print Parameters
	To change prototype parameters:
	Editing Functions
	Change Image Filenames
	Saving a Job Ticket

	The Detail Property Sheet
	Main Tabbed Dialog Box
	Specified Size Tabbed Dialog Box
	Output Setup Tabbed Dialog Box
	Data Format Tabbed Dialog Box
	Pens tabbed dialog box
	Pen/Print Options Tabbed Dialog Box
	Overlays Tabbed Dialog Box
	Watermarks Tabbed Dialog Box
	Margins Tabbed Dialog Box
	Labels Tabbed Dialog Box

	Saving and applying options selected from the Detail Property Sheet
	Saving and applying a Pen Set
	Saving and applying watermark, margin and label settings

	The Scale View
	Setting Preferences
	General Preferences tabbed dialog box
	User Information Tabbed Dialog Box
	Finishing Options
	Nesting Options Tab

	Processing Options
	Processing tabbed dialog box
	Size Tolerances Sheet
	AutoCAD/DWG Direct Setup Sheet

	Adding Files from a Polled Directory
	Creating the Directories:
	Using the Poll Directory Function:

	Adding Files from a Polled FTP Directory
	Using the Poll Directory Function:

	Scanning from Twain Devices
	Confirming your computer detects the scanner:
	Twain Scanning Options
	Adding images to the Job Editor from a TWAIN scanner:

	Output to File
	Using Output to File

	Revision Highlighting
	Using Revision Highlighting
	Revision Highlighting Options
	The File Configuration Tabbed Dialog Box
	The Revision Highlighting Dialog Box Buttons
	Possible error messages generated by Revision Highlighting

	Process Image Files
	The Process Job dialog box

	Viewing Image Files
	The PlotWorks Image Viewer
	The Windows XP Viewer
	Viewing an image

	Configure an Output Destination
	Configuring Multiple Destinations
	Destination Types
	Edit an existing Output Destination
	Delete an existing Output Destination

	Sending Print Jobs
	Send a Special Instruction File
	Job Information

	Output Jobs
	Output to FTP




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


